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ОПРЕДЕЛЕНИЯ, ОБОЗНАЧЕНИЯ И СОКРАЩЕНИЯ 

ЖРД  – жидкостный ракетный двигатель 

ЖГГ – жидкостный газогенератор 

ТНА  – турбонасосный агрегат 

НДС – напряжѐнно-деформированное состояние 

CAD  – сomputer-aided design  

CAE  – сomputer-aided engineering 

ЛКМ – левая кнопка мыши 

ПКМ – правая кнопка мыши 

РК     – рабочее колесо 

ГУ    – граничное условие 
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ВВЕДЕНИЕ 

         Настоящее учебное пособие «Сопряжѐнное моделирование рабочего колеса турбины 

турбонасосного агрегата ЖРД » представляет собой часть комплекса пособий, предназна-

ченных для подготовки высококвалифицированных специалистов по специальности 

160302 «Ракетные двигатели» и направлениям подготовки 160700.65 «Проектирование 

авиационных и ракетных двигателей» и 160700.68 «Двигатели летательных аппаратов» на 

основе  использования сопряжѐнных (гидро- и газодинамических, термодинамических, 

тепловых, прочностных, деформационных, динамических и технологических) моделей 

оценки параметров эффективности создаваемых изделий и управления ими на этапах про-

ектирования и доводки. 

           На основе данных, полученных в ходе выполнения курсовых проектов по дисцип-

линам «Теория и расчѐт лопаточных машин агрегатов ракетных двигателей», «Проектиро-

вание турбонасосных агрегатов» студенту предлагается самостоятельно, получая консуль-

тации преподавателя, рассчитывать напряжѐнно-деформированное состояние рабочего 

колеса турбины турбонасосного агрегата жидкостного ракетного двигателя в сопряжѐнной 

постановке. Для этого необходимо сначала рассчитать гидродинамические процессы в ос-

новном тракте турбины, затем усложнить модель включением в расчѐт притрактовых по-

лостей и учѐтом влияния теплообмена с материалом диска турбины [1], а далее, используя 

полученные данные в качестве граничных условий, рассчитать напряжѐнно-

деформированное состояния рабочего колеса. 

В качестве примера использована основная турбина турбонасосного агрегата жидко-

стного ракетного двигателя. Турбина осевая, одноступенчатая, бандажированная.  

Внешний вид рабочего колеса этой турбины представлен на рисунке 1. 

 
Рис. 1. Твѐрдотельная модель рабочего колеса турбины 
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        Рабочее тело этой турбины представляет собой генераторный газ, полученный в ре-

зультате горения переобедненной топливовоздушной смеси. На расчѐтном режиме основ-

ная газовая турбина обеспечивает следующие параметры: 

полное давление газа на входе в турбину Р*вх  = 32,5 МПа 

полная температура газа на входе в турбину             Т*гг = 650 К 

секундный расход газа              Gгг = 368,5 кг/с 

полное давление газа на выходе из турбины               Р*вых = 17,66, МПа 

частота вращения ротора                n =17458 об/мин 

суммарный КПД турбины в параметрах торможения  η* т =0,74 

показатель адиабаты генераторного газа                     k =1.33 

степень расширения газа в турбине                 π*т =1,85 
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1 ОСОБЕННОСТИ ФИЗИЧЕСКИХ ПРОЦЕССОВ В РАБОЧИХ КОЛЁСАХ  

ТУРБИН ТНА  

1.1 Общие требования к турбинам ТНА ЖРД и параметры,  

определяющие их эффективность 

         Для привода насосов ЖРД обычно используются газовые или жидкостные турбины. 

Их преимуществами перед другими типами приводов являются большая удельная массо-

вая мощность (мощность на единицу массы конструкции), малый удельный расход рабо-

чего тела (расход на единицу мощности), высокие частоты вращения и простота соедине-

ния с лопаточными насосами. 

         По назначению турбины ТНА можно разделить на пусковые и основные. Пусковая 

турбина обеспечивает раскрутку насосов только в начальный момент запуска, а основная 

— их вращение в течение всего времени работы двигателя. Кроме того, если основная 

турбина приводит во вращение насосы ТНА ЖРД без дожигания, то еѐ называют авто-

номной. Если же основная турбина установлена в ТНА ЖРД с дожиганием, она называет-

ся предкамерной [2, 3, 7, 8, 12 ] 

         Основными параметрами турбины являются: 

        NT — мощность; 

        πt — степень расширения рабочего тела в турбине; 

        Tвх — температура рабочего тела на входе в турбину; 

        — угловая скорость ротора; 

         ηT — КПД турбины. 

         Мощность турбины ТНА, равная суммарной мощности приводимых насосов и до-

полнительным затратам (потери на трение и др.), может достигать весьма больших вели-

чин. Так, например, турбина ТНА ЖРД  F-1 имеет мощность 44,2 МВт, а турбина водо-

родного ТНА ЖРД SSME — 56 МВт. 

         Степень расширения рабочего тела в турбине определяется выражением 

 , 

где   – давление на входе в турбину; 

 – давление на выходе из турбины. 

         Величина  зависит от назначения турбины. Величина  рвых зависит от схемы дви-

гателя, способа регулирования перепада давления на турбине в полѐте и возможности ис-

пользования газа после выхода из турбины для получения дополнительной тяги от выхло-

па.  

          Для пусковых и основных автономных турбин   = 20...50, а для предкамерных — 

 = 1,2...1,8 [2, 12, 13]. Турбина ЖРД с дожиганием высокорасходная, низкоперепадная. 

Она работает при малых скоростях газового потока и давлении на выходе, превышающем 

давление в камере сгорания рk: 
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рвых > рk . 

             Температура рабочего тела перед турбиной ограничена прочностью материала кон-

струкции (в основном, рабочих лопаток и дисков, как наиболее нагруженных элементов). 

Исходя из требований обеспечения малой массы и простоты конструкции, в ТНА исполь-

зуются неохлаждаемые лопатки. Поэтому температура на входе в турбину при стальных 

лопатках ограничивается величиной Tвх = 1000...1200 К при восстановительном и 700...800 

К при окислительном газе. 

         Угловая скорость вращения ротора ω определяет его силовую напряженность, КПД 

и габариты турбины. При однороторной конструкции ТНА она ограничивается условием 

бескавитационной работы насосов. Если же турбина приводит во вращение насосы через 

редуктор, то угловую скорость вращения ротора турбины выбирают из условия получения 

ηTмакс и минимального радиального габарита. Для роторов современных турбин  

 = (3...5) • 10
3
 рад /с, а может быть и больше. Например, турбина водородного ТНА дви-

гателя РД0146 конструкции КБХА (г. Воронеж) вращается с частотой 123000 об/мин [10].  

         КПД турбины зависит от отношения U/Сад,               

  где  U — окружная скорость на среднем  диаметре  лопаток; 

        Сад — скорость потока после его расширения от рвх  до . 

        Для одноступенчатых турбин КПД может достигать величины 0,8, а для двухступен-

чатых — 0,6. 

В качестве привода насосов в ТНА применяются преимущественно газовые турби-

ны, обладающие малыми габаритами и массой при высоком значении располагаемой 

удельной мощности. Выбор вида турбины и основных параметров, а также связь еѐ пара-

метров с характеристиками ЖРД подробно изложены в учебнике [12] и учебном  

пособии [2].  

 По направлению движения рабочего тела газовые турбины разделяются на осевые и 

радиальные, последние являются центростремительными. Осевые турбины получили ши-

рокое применение в ТНА ЖРД без дожигания и с дожиганием. В первом случае турбины 

высокоперепадные и активные, одно- и двухступенчатые. Во втором случае, как правило, 

одноступенчатые и низкоперепадные. Предкамерная турбина, как осевая, так и радиальная 

центростремительная, как правило, реактивные.  

 В сопловом аппарате турбины потенциальная энергия рабочего тела преобразует-

ся в кинетическую. Газовый поток поступает на рабочую решѐтку турбины со скоро-

стью Сад и совершает работу, вращая ротор ТНА с угловой скоростью ω.  

 Обычно турбины ТНА работают в области малых значений параметра U/Cад, т.е. 

при невысокой нагруженности ступени, что определяет еѐ низкий КПД. 

         Скорость вращения ротора ТНА ограничивается условием бесквитационной работы 

насосов. Для увеличения окружной скорости на лопатках турбины повышают еѐ диаметр, 

но так, чтобы из условия прочности рабочего колеса Uсрmax  не превышала 350…450 м/с.  
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         Для турбин ТНА Dср составляет (1,5…2) D2 наружного диаметра колеса насоса горю-

чего. 

 В активных турбинах ТНА угол α1 = 15…20º и Сад = 900…1500 м/с. Для повышения 

КПД можно увеличить еѐ угловую скорость ω, применив редукторную схему ТНА (см. 

рис. 1.1, б пособия [14]) или двухступенчатую турбину. Однако это приводит к усложне-

нию конструкции, росту габаритов и массы ТНА. 

 Полезная (располагаемая) мощность турбины складывается из суммы мощностей, 

потребных для привода всех насосов: основных – шнекоцентробежных (горючего и окис-

лителя), бустерных, а при необходимости и вспомогательных (подача третьего компонен-

та, рабочего тела наддува баков и т.п.). 

NT = Σ NH = NБО + NБГ + NО + NГ. 

По величине располагаемой (адиабатной) работы Lад  определяется мощность турби-

ны 

NТ = адL  m  ηT , 

где  – расход газа, кг/с; 

     ηT  – КПД турбины. 

Работоспособность газа RT0 при заданных компонентах топлива определяется его 

температурой перед сопловым аппаратом. В зависимости от материала лопаток и диска 

газовой турбины, их стойкости в среде рабочего тела (окислительная или восстановитель-

ная), режимов и ресурса двигателя температура принимается в пределах To = 600…1000 К. 

         Основными требованиями, предъявляемыми к турбинам ТНА, являются: 

         - как можно большая величина Сад, что особенно важно для автономных турбин, так 

как при этом уменьшается расход рабочего тела через турбину и повышается удельный 

импульс ДУ; 

         - высокий КПД, что позволяет снижать расход рабочего тела через автономную тур-

бину, а в предкамерной турбине — давление на еѐ входе и, следовательно, массу конст-

рукции ДУ; 

         - возможно большая скорость вращения ротора, что позволяет уменьшать радиаль-

ный габарит турбины.  

        Эти требования определяют конструктивные особенности и параметры турбин ТНА 

ЖРД, технологию изготовления, сборки и доводки изделия. Обоснованная методология 

выбора путей деятельности в этих направлениях является основным условием удовлетво-

рения отмеченным требованиям. 

         Турбина, как и насос, имеет подводящее устройство, рабочий орган и отводящее уст-

ройство. Подводящее устройство состоит из входного патрубка, коллектора для распреде-

ления рабочего тела по окружности колеса и соплового аппарата. В последнем происходит 

увеличение скорости рабочего тела вследствие его расширения. Рабочим органом турби-

ны является колесо с рабочими лопатками, образующими каналы, в которых происходит 

преобразование энергии рабочего тела и выхлопного патрубка. 
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         В зависимости от направления потока рабочего тела относительно оси колеса разли-

чают осевые и радиальные турбины. Если расширение рабочего тела происходит только в 

сопловом аппарате, то турбину называют активной. Если же расширение его происходит 

и в каналах колеса, то такую турбину называют реактивной. Активная турбина может 

иметь несколько ступеней, в которых последовательно срабатываются или перепад давле-

ния рабочего тела (турбины со ступенями давления), или же скорость потока, полученная 

в сопловом аппарате первой ступени (турбины со ступенями скорости).  
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1.2 Конструктивные особенности и условия работы колѐс турбин ТНА 

1.2.1 Осевые турбины ТНА 

         Для привода насосов в ТНА ЖРД применяют в основном осевые турбины. Они име-

ют меньшие габариты и массу по сравнению с радиальными, хотя и уступают последним в 

некоторых случаях в величине максимального КПД и простоте изготовления. Чаще всего 

применяют безредукторную схему привода насосов, при которой число оборотов турбины 

ограничивается условием бескавитационной работы насосов, в результате чего величина 

окружной скорости U будет невысокой. 

         При проектировании автономных турбин желательно реализовать максимальную ве-

личину Сад. В этом случае используют высокоперепадные активные турбины, которые при 

малых значениях U/Сад  имеют более высокий КПД, чем реактивные. В ТНА малой мощ-

ности обычно используют одноступенчатые турбины, а в более мощных — двухступенча-

тые со ступенями скорости. При малых отношениях U/Сад двухступенчатая активная тур-

бина со ступенями скорости имеет более высокий КПД, чем одноступенчатая. Однако при 

небольших мощностях турбины еѐ КПД оказывает слабое влияние на величину Iу. Поэто-

му решающими факторами при выборе типа турбины будут простота конструкции и тех-

нологии изготовления деталей, а также меньшие время доводки, стоимость и масса, свой-

ственные одноступенчатой турбине. При больших мощностях ТНА влияние КПД турбины 

на Iу увеличивается, и в этом случае целесообразнее использовать двухступенчатую тур-

бину. Кроме того, она может иметь и меньшую массу, так как при большой мощности 

приходится увеличивать диаметр одноступенчатой турбины, а следовательно, и толщину 

ее диска. 

         В качестве предкамерных турбин применяются чаще всего реактивные одно- и двух-

ступенчатые турбины, так как при малом πт значение Сад будет небольшим, возрастет от-

ношение U/Сад и КПД реактивной турбины будет выше. Для снижения осевого усилия, 

действующего на колесо, степень реактивности турбины выбирают небольшой (порядка 

0,2...0,3 на среднем радиусе лопаточного венца). Иногда с этой же целью используют од-

ноступенчатые активные турбины. 

          В качестве пусковых турбин, применяемых в некоторых ТНА ЖРД с дожиганием, 

используют одноступенчатые осевые активные турбины с парциальным подводом газа. 

Несмотря на то, что эти турбины работают кратковременно (1 ...2 с), приходится прини-

мать меры по повышению стойкости сопел и рабочих лопаток, поскольку температура га-

за, получаемого в газогенераторе твѐрдого топлива, обычно превышает температуру газа 

ЖГГ. 

          Корпус осевой турбины обычно состоит из двух частей, соединяемых фланцами или 

сваркой. В одной из них объединяют входной патрубок, коллектор и сопловой аппарат, а 

во второй — сборник рабочего тела и выходной патрубок. 

         Если турбина расположена на валу консольно, то в автономных турбинах подводя-

щее устройство обычно расположено со стороны насоса, а отводящее — снаружи ТНА. 

При этом подвод газа в коллектор и отвод его из газосборника осуществляют с помощью 

тангенциальных или радиальных патрубков. В предкамерных турбинах обычно применя-
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ют осевой входной патрубок, который совместно с входным коком образует коллектор, а 

отводящее устройство имеет радиальный выходной патрубок. При этом уменьшаются 

гидравлические потери па входе и удобно компонуются ЖГГ и турбина. 

         При консольном расположении корпус турбины обычно не включается в силовую 

систему «ротор—корпус» ТНА и поэтому может быть выполнен сваркой деталей из лис-

тового материала, а для увеличения жѐсткости подкреплѐн рѐбрами. И хотя вал, который 

передаѐт весь крутящий момент от колеса насосам, получается на определѐнном участке 

более массивным, в общем масса турбины при этом будет меньше. При расположении 

турбины между насосами подвод и отвод газа осуществляют с помощью тангенциальных 

патрубков и кольцевых коллектора и сборника. Корпус турбины в этом случае включают в 

силовую систему «ротор – корпус» ТНА, и поэтому его элементы изготавливают штам-

повкой или литьѐм по выплавляемым моделям. 

         Полости, по которым протекает газ с высокими давлением и температурой, изоли-

руют от полостей подшипников системой подвижных уплотнений. С целью уменьшения 

тепловых потерь при использовании парогаза трубопровод от парогазогенератора и кол-

лектор турбины иногда изолируют стекловатой. При высокой температуре генераторного 

газа для предотвращения нагрева соседних агрегатов теплоизолируют корпус турбины 

или, наоборот, корпус насоса. 

          Технические требования, предъявляемые к точности обработки и шероховатости по-

верхностей корпусов турбин при изготовлении, аналогичны требованиям к корпусам на-

сосов. Материалами для изготовления корпусов являются алюминиевые или титановые 

сплавы, если температура газа не превышает 700...800 К, или легированные и нержавею-

щие стали и сплавы (ЗОХГСА, 12Х18Н9Т, 15Х18Н12СЧТЮ и др.), если температура газа 

выше. 

         После изготовления корпус подвергают гидро- и пневмоопрессовке. Для проверки 

жѐсткости замеряют деформации корпуса с помощью тензодатчиков или индикаторов пе-

ремещения, а при проверке запаса прочности несколько корпусов из партии нагружают до 

разрушения. 

          Сопловые и направляющие аппараты. В автономных турбинах скорость на выходе 

из соплового аппарата будет сверхзвуковой. Поэтому каналы соплового аппарата состоят 

из сужающейся и расширяющейся частей. Они могут иметь осесимметричную (рис. 1.1, а, 

б) или же сегментную (рис. 1.1, в) форму. Для обеспечения необходимого направления 

потока газа на входе в каналы колеса, образованные рабочими лопатками, каналы сопло-

вого аппарата располагаются под определенным углом к плоскости вращения лопаточного 

венца и на выходе оканчиваются косым срезом, при котором выходное сечение осесим-

метричного сопла имеет форму эллипса. 
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Рис. 1.1 Сопло и сопловые решѐтки турбин: одиночное (а) и групповое (б) осесимметрич-

ные сопла; сопловая (в) и направляющая (г) решѐтки активных турбин; дозвуковая (д) и 

околозвуковая (е) сопловые решѐтки реактивных турбин 

         В предкамерных турбинах скорость на выходе из соплового аппарата будет дозвуко-

вой (М = 0,4...0,9) или околозвуковой (0,9<М< 1,2), вследствие чего каналы сопел имеют 

сужающуюся форму (рис. 1.1, д, е). 

         В автономных турбинах подвод небольшого расхода газа к рабочим лопаткам по 

всей окружности колеса возможен только при малой высоте сопловых каналов и самих 

рабочих лопаток, что приводит к резкому падению КПД турбины вследствие больших 

гидравлических потерь в межлопаточных каналах и потерь при перетекании газа в отно-

сительно большом радиальном зазоре между концами лопаток и корпусом турбины. 

Уменьшить эти потери можно лишь увеличением высоты лопаток. Поэтому подвод газа 

обычно осуществляют по части окружности колеса (парциальный подвод), для чего от-

дельные сопла располагают по окружности с определѐнным шагом или же группируют па 

одном участке. При парциальном подводе также возникают дополнительные потери, но 

они будут меньше, чем при подводе по всей окружности колеса. Дополнительные потери 

от парциальности будут наименьшими при группировании сопел на одном участке, но при 

этом увеличивается вибрация лопаток и возникает радиальная сила, действующая на коле-

со. Для уменьшения уровня вибрации увеличивают осевой зазор между сопловым аппара-

том и лопаточным венцом колеса, что ведѐт к снижению КПД турбины. Поэтому количе-

ство мест подвода, их расположение и величину осевого зазора выбирают, исходя из ус-

ловий обеспечения работоспособности лопаток и приемлемого КПД турбины. Размеры 

сечений каналов сопел определяются газодинамическими расчѐтами [2, 12]. 

        Сопловой аппарат при парциальном подводе изготавливают в виде отдельных втулок, 

вваренных в коллектор турбины, или сегментов с несколькими соплами, вставленных в 

прорезь коллектора и закреплѐнных винтами или сваркой, или в виде сверлений в корпус-

ной детали. При достаточно большом объѐмном расходе (при малой плотности газа или 
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низких его параметрах) подвод газа может быть осуществлѐн по всей окружности колеса. 

В этом случае сопловой аппарат набирают из отдельных сопловых лопаток, приваривае-

мых к внутреннему и наружному кольцам, или отливают вместе с коллектором по вы-

плавляемым моделям.  

         В двухступенчатой турбине со ступенями скорости перед вторым венцом рабочих 

лопаток устанавливают направляющий аппарат, в каналах которого происходит только 

изменение направления потока и уменьшение скорости вследствие потерь на трение. Ло-

патки такого аппарата имеют симметричную форму (рис.1.1, г). При двухвенечном диске 

турбины лопатки направляющего аппарата изготавливают отдельно и с помощью замка 

крепят в пазах сегментов, образующих наружное кольцо. Внутреннее кольцо образуется 

полками лопаток. Сегменты кольца зажимают с помощью выступов между корпусами 

турбины. Если турбина двухдисковая, то направляющий аппарат может быть неразъем-

ным. Тогда его или набирают из отдельных лопаток, или же отливают по выплавляемым 

моделям. 

         Для устранения перетекания газа помимо каналов направляющего аппарата устанав-

ливают радиальные или торцевые лабиринтные уплотнения. 

         При парциальном подводе газа направляющий аппарат располагают только против 

участка, занятого соплами. 

         В предкамерных турбинах расход газа достаточно велик для того, чтобы получить 

приемлемую высоту сопловых каналов и рабочих лопаток при подводе газа по всей ок-

ружности колеса. Кроме того, в реактивных турбинах при парциальном подводе газа его 

перетекание через межлопаточные каналы вне зоны соплового блока не позволяет под-

держивать на рабочих лопатках требуемый перепад давления. 

         Колесо турбины состоит из диска и лопаточного венца. Лопатки венца могут быть 

съѐмными или же выполняются вместе с диском. 

         Съѐмная лопатка (рис. 1.2) состоит из ножки (корневой части) и пера (профилиро-

ванной части). С помощью пера лопаток образуются боковые стенки межлопаточных ка-

налов, в которых происходит преобразование энергии рабочего тела турбины в механиче-

скую энергию вращения колеса. Перо образуется двумя поверхностями — выпуклой, ко-

торая называется спинкой, вогнутой ( корытцем) и двумя кромками — входной и выход-

ной. 
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Рис. 1.2. Рабочие лопатки турбин:  

а — одиночные с полками; б, в — блоки пустотелых и сплошных лопаток ; 

 г — лопатка с демпфером; 1 — ножка; 2 — перо; 3 — полка; 4 — уплотняющий выступ; 

5 — корытце; 6 — спинка; 7 — демпфер 

         Ножка служит для крепления лопатки к диску. Она имеет выступы, которые входят в 

пазы диска и образуют замок. 

         Съѐмные лопатки изготавливаются штамповкой с последующей механической обра-

боткой поверхностей (рис. 1.2, а) или же литьем по выплавляемым моделям. Иногда отли-

вается две – три лопатки с одной ножкой (рис. 1.2, б, в). Для уменьшения массы лопатки 

активных турбин могут отливаться пустотелыми (рис. 1.2, б). При обтекании лопатки га-

зом на еѐ спинке образуется разрежение, и поэтому возникает перетекание газа через еѐ 

торец. Это приводит к снижению КПД турбины (особенно при коротких лопатках). Для 

устранения этих утечек па концах лопаток делают полки, образующие наружный бандаж 

лопаточного венца (рис. 1.2, а). Иногда бандаж представляет собой кольцо, приклѐпанное 

или приваренное к торцам лопаток. Для компенсации термического расширения материа-

ла в кольце делают три – четыре косых разреза шириной 0,5... 1,0 мм. На поверхности 

бандажа вытачивают кольцевые треугольные выступы, которые вместе с графитовыми 

вкладышами корпуса турбины образуют лабиринтное уплотнение с весьма малым ради-

альным зазором, препятствующее перетеканию газа помимо межлопаточных каналов. 

Применение бандажа позволяет существенно повысить КПД турбины (на 5... 10%). К тому 

же бандаж, связывая лопатки в пакет, увеличивает их изгибную жѐсткость и повышает 

частоту собственных колебаний. Однако бандаж нагружает лопатку дополнительно цен-

тробежной силой. По условиям обеспечения статической прочности он не всегда может 

быть применѐн. 

         Параметры потока газа, подводимого к лопаткам колеса, неравномерны по окружно-

сти вследствие парциальности подвода или, при подводе по всей окружности, вследствие 

перекрытия потока лопатками соплового аппарата. Поэтому на лопатки рабочего колеса 
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действует возбуждающая сила. Лопатки предкамерных турбин, особенно при питании по-

следних генераторным газом малой плотности, имеют сравнительно большую высоту, и 

частоты их собственных изгибных колебаний по низшим формам могут совпадать с час-

тотой возбуждающей силы. При резонансных колебаниях вследствие явления усталости 

материала возможно появление в лопатках трещин. Если отстройка по частотам невоз-

можна, в колебательную систему вводится конструкционное демпфирование. Для этого 

при постановке лопаток в диск между торцами верхних полок обеспечивают небольшой 

зазор, и вследствие трения по торцам полок энергия колебаний рассеивается. При отсутст-

вии верхних полок эффективное рассеяние энергии колебаний можно обеспечить исполь-

зованием пластинчатого демпфера в пазах полок внутреннего бандажа (рис. 1.2, г) или 

демпферов других конструкций.   

         Характерные размеры лопаток рабочего колеса турбины показаны на рисунке1.3. 

.  

Рис. 1.3. Характерные размеры рабочей лопатки активной осевой турбины: 

а — меридиональное сечение; б — развертка по радиусу 

         Профиль сечения пера лопатки активной турбины имеет симметричную относитель-

но срединной плоскости колеса форму и одинаковые входные и выходные углы профиля 

(β1 = β2). В автономных турбинах даже при парциальном подводе рабочего тела лопатки 

получаются короткими (Dcр/h > 8, h = 20...40 мм). Поэтому для упрощения технологии 

изготовления размеры сечений по высоте пера обычно выдерживают постоянными. 

         Сечение пера лопатки реактивной турбины (см. рис. 1.1, д) выполняют несиммет-

ричным с различными углами профиля (β1 >β2), причем, исходя из условий прочности, 

размеры сечений по высоте пера лопатки уменьшают. Если лопатки длинные (Dcp/h < 8), 

то перо может иметь закрутку по высоте, при которой концевой профиль повернут отно-

сительно корневого на определѐнный угол. Закрутка необходима для обеспечения ради-

ального равновесия газа при течении его в межлопаточном канале. 
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         Высота пера лопатки h выбирается несколько большей высоты лопатки соплового 

аппарата hc (рис. 1.3). Это необходимо, чтобы обеспечить нормальное течение газа при 

несоосности соплового и рабочего лопаточных венцов вследствие технологических по-

грешностей или прогиба вала при колебаниях ротора. Величина перекрытия лопаток со-

ставляет обычно для активной турбины на периферии 1...2мм, у корня 0...1 мм, а для реак-

тивной — примерно вдвое больше. Чрезмерная величина перекрытия вызывает дополни-

тельные потери на вихреобразование в застойных зонах. 

          Высота лопатки может быть постоянной или увеличивающейся по еѐ ширине (по-

следнее характерно для активных турбин). Угол уширения у берѐтся в пределах 8... 15°, 

так как при большем угле может быть отрыв потока от поверхности канала.  

          Ширину лопаток b выбирают минимальной, обеспечивая отношение h1/b >1. Исходя 

из технологических соображений и условия обеспечения прочности, ширина лопаток ак-

тивных турбин должна быть 8...15 мм, а реактивных—15...20 мм. Толщина кромок лопа-

ток 𝛥 обычно составляет 1...2 мм. Лопатки устанавливаются на ободе диска с шагом s = 

(0,7...0,5)b. При небандажированных лопатках для уменьшения перетекания газа старают-

ся свести к минимуму радиальный зазор δР (см. рис. 1.3) между концами лопаток и корпу-

сом турбины (примерно до величины 0,4...0,6 мм на рабочем режиме). 

         Осевой зазор δо между сопловыми и рабочими лопатками обычно выбирают в преде-

лах 2...3 мм для активных и 4...5 мм для реактивных турбин. 

         Лопатки могут быть выполнены вместе с одновенечным диском, приварены к нему 

или соединены с ним с помощью замков различного типа, как изображено на рис.1.4. В 

первом случае будет минимальной масса колеса, но усложняется технологии его изготов-

ления, так как при обработке лопаток трудно получить точные размеры и нужную шеро-

ховатость поверхностей каналов. Если лопатки не имеют бандажа, то их вначале форми-

руют электроэрозионным способом, а затем необходимые размеры и шероховатость по-

верхностей обеспечивают с помощью электрохимической обработки. Лопатки с бандажом 

отливают по выплавляемым моделям заодно с диском и затем механически обрабатывают 

лишь их боковые поверхности и наружную поверхность бандажа. Проще технология про-

изводства приварных лопаток, так как их изготавливают отдельно от диска (штамповкой 

или литьѐм) и механически обрабатывают, что обеспечивает более высокие точность раз-

меров и чистоту поверхностей пера. Затем комплект лопаток закрепляют в приспособле-

нии в том положении, в каком они должны быть приварены к диску. Их корневую часть 

протачивают под сварку и производят сварку с диском. Однако при сварке трудно полу-

чить точное расположение лопаток, поэтому после неѐ боковые поверхности обода диска, 

полок и наружную поверхность бандажа механически обрабатывают. 
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Рис. 1.4. Типы крепления лопаток к одновенечному диску турбины: 

а — за одно целое; б — сварное; в, г, д — соответственно, с помощью ѐлочного, Т-

образного и штифтового замков 

         Если материал лопаток не сваривается с материалом диска, то применяют замковое 

соединение, хотя это усложняет технологию изготовления диска и лопаток, а также уве-

личивает массу ротора. В этом случае на ножке лопатки делают выступы, a в ободе диска 

— соответствующие пазы. В турбинах ТНА наиболее распространены замки ѐлочного, Т-

образного типов и штифтовые. 

         Ёлочный замок (см. рис. 1.4, в) применяют при больших нагрузках на лопатку, так 

как при этом усилия распределяются по нескольким зубьям замка. Но такой замок являет-

ся наиболее сложным в изготовлении, так как необходимо обеспечивать одновременное 

прилегание деталей по нескольким поверхностям. Пазы в ободе диска могут иметь осевое 

направление (см. рис. 1.2, а), или же протачивается один кольцевой паз ( см. рис. 1.4, в), 

лопатки в который вставляются через боковую прорезь, закрываемую вставкой. 

         При небольших нагрузках па лопатку используются Т-образные (см. рис. 1.4, г) и 

штифтовые (см. рис.1.4, д) замки, для которых на ободе протачиваются один или несколь-

ко кольцевых пазов (при вильчатом штифтовом замке). Технология изготовления и сборки 

таких соединений проще, чем ѐлочного. 

         Соединение лопаток с двухвенечным диском может быть осуществлено Т-образным 

замком ( рис. 1.5, а) или с помощью ѐлочного замка ( рис. 1.5, б).  
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Рис. 1.5. Типы крепления лопаток к двухвенечному диску турбины: 

с помощью Т-образного (а) и ѐлочного (б) замков 

         Сопловые и особенно рабочие лопатки работают в тяжѐлых условиях при высоких 

температурах, в среде коррозионно-активного газа, при неравномерном нагреве, а рабочие 

лопатки — еще и при действии больших центробежных сил. Поэтому при изготовлении 

требуется обеспечивать следующие технические требования: 

         - отклонение формы контуров корытца и спинки 0,1...0,3 мм; отклонение максималь-

ной толщины профиля пера от номинала не более 0,2 мм; 

         - допуск на толщину выходной кромки 0,1...0,4 мм; шероховатость пера лопатки 

0,63...0,32 мкм; допуск на угол профиля 20...30'; 

         - допуск на шаг зубьев елочного замка 0,01...0,02 мм; 

         - допуск на толщину замка по средней линии зубьев 0,02...0,06 мм; 

         - допуск на угол между зубьями  ± 10...40'; 

         - допуск отверстия под штифт замка — по 4-му квалитету. 

         Сопловые и рабочие лопатки изготавливаются фрезерованием из жаропрочных мате-

риалов, обладающих удовлетворительной обрабатываемостью давлением и резанием 

(12Х18Н9Т,  ХН77ТЮР), или отливаются из сплавов (ЖС-3, ЖС-6К, ЛК-4). При работе 

турбины на парогазе лопатки могут изготавливаться из алюминиевых сплавов типа АК 

или стали 30ХГСА. 

         В процессе изготовления лопатки тщательно контролируются — проверяется соот-

ветствие размеров лопатки и шероховатости поверхности заданным по чертежу. 

         Поверхность пера лопатки из алюминиевого сплава подвергается анодированию. Для 

повышения жаростойкости стальные лопатки покрываются жаростойкими эмалями. 

         Диск турбины состоит из обода — утолщѐнной периферийной части, к которой кре-

пятся замки лопаток, полотна — наиболее тонкой части диска и ступицы — утолщѐнной 
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центральной части, с помощью которой диск крепится к валу. Ступица может иметь от-

верстие для посадки на вал или же цилиндрические выступы для центрирования по нему. 

         Способ крепления диска к валу определяется местом расположения первого, величи-

ной передаваемых усилий, числом ступеней турбины, способом охлаждения деталей, ма-

териалами, технологией изготовления и сборки. Крепление должно обеспечить: 

         - передачу на вал заданного крутящего момента; 

         - сохранение центровки и фиксации деталей в холодном и горячем состояниях, что 

обеспечивает сохранение балансировки ротора; 

         - минимальную передачу тепла от лопаток через диск валу во избежание перегрева 

подшипников. 

         Соединение диска с валом может быть неразборным или разборным. Неразборное 

соединение снижает массу конструкции, но сложнее разборного в изготовлении, если диск 

выполнен заодно свалом. Несколько проще изготовление сварного соединения или соеди-

нения на радиальных штифтах. В последнем случае диск центрируется по валу путѐм 

плотной посадки и фиксируется радиальными или наклонными штифтами, которые также 

передают и крутящий момент. От выхода из гнѐзд под действием центробежной силы 

штифты удерживаются завальцовкой отверстий над ними. Обычно неразборное соедине-

ние используется при малой мощности турбины. 

         Разборное соединение упрощает изготовление и сборку турбины, но при этом воз-

растает масса ротора и возникает возможность нарушения его балансировки при перебор-

ке. Диск может быть присоединѐн к валу непосредственно или через промежуточный эле-

мент. В первом случае диск может быть закреплѐн с помощью фланцевого соединения 

винтами или болтами. Центровка при этом осуществляется посадкой по цилиндрическим 

пояскам фланцев или по поверхности вала, а передача крутящего момента — призонными 

штифтами или болтами. Возможно также соединение с помощью торцевых или цилинд-

рических шлицев. Если диск выполнен из алюминиевого сплава, то он присоединяется 

через стальной переходный конус или переходные стальные втулки. 

         В двухступенчатых турбинах может применяться одно- или двухдисковая конструк-

ция. При однодисковой конструкции обод диска имеет два лопаточных венца (см. рис. 1.3) 

и поэтому получается широким. Такая конструкция усложняет установку направляющего 

аппарата и при большой окружной скорости не может применяться по условию обеспече-

ния прочности. Поэтому чаще используются двухдисковые конструкции, в которых креп-

ление дисков к фланцу вала осуществляется обычно с помощью шпилек, а центрирование 

и передача крутящего момента — призонными втулками. 

         Диски турбин, как и лопатки, работают в тяжѐлых условиях. Поэтому они изготавли-

ваются механической обработкой штампованных заготовок из жаропрочных сталей и 

сплавов (12Х18Н9Т, ХН77ТЮР) или отливкой вместе с лопатками по выплавляемым мо-

делям из сплавов ЖС-3, ЖС-6К, ЛК-4. Только в турбинах, работающих на парогазе, для 

дисков можно применять алюминиевые или титановые сплавы. 

         При изготовлении диска посадочные пояски и отверстия выполняются: 

        - по 6—7-му квалитетам;  
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        - допуски на биения посадочных поверхностей составляют не более 0,03...0,05 мм, на 

размер паза для крепления лопатки — 0,01 ...0,03 мм; 

        - шероховатость посадочных поверхностей должна быть равна 1,25 мкм, а для ос-

тальных — 2,5 мкм. 

        После изготовления рабочее колесо (диск вместе с лопатками) проходит статическую 

балансировку. 

         Вал турбины обычно имеет сложную форму, так как на нѐм предусматриваются по-

садочные поверхности под подшипники и уплотнения, шлицы или фланец для крепления 

диска и резьба для гаек. На вал действуют нагрузки разных природы и характера [5, 6].Для 

снижения массы его выполняют пустотелым, иногда — с радиальными сверлениями, че-

рез которые отводится смазывающий подшипники компонент. Через вал передаются кру-

тящий момент, осевые и радиальные усилия, а в его материале возникают температурные 

напряжения от неравномерного нагрева по длине и радиусу. Валы ТНА обычно вращают-

ся с большой частотой. Все это обуславливает применение для их изготовления таких вы-

соколегированных сталей, как 38ХА, 2X13, 18ХНВА, 40XНМЛ, с термохимическим их 

упрочнением и назначение весьма жѐстких допусков на точность и шероховатость обра-

ботки. Так, например, для обработки посадочных мест под подшипники должны быть вы-

полнены следующие условия: 

         - точность изготовления по 4—7-му квалитетам;  

         - отклонение геометрической формы 0,005...0,02 мм; 

         - биение поверхностей относительно друг друга 0,01...0,04 мм;      

         - шероховатость обработки поверхностей 1,25...0,16 мкм.  

        Остальные поверхности изготавливаются по 8—11-му квалитетам и с шероховато-

стью Rz = 2,0...2,5 мкм. 
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1.2.2  Радиальные турбины ТНА 

         Радиально-осевая центростремительная турбина (рис. 1.6) состоит из тангенциально-

го (радиального) подводящего патрубка 5, спирального торового коллектора 1, радиально-

го соплового аппарата 2, радиально-осевого колеса и осевого выхлопного патрубка 4. По-

ток рабочего тела, поступая из соплового аппарата в межлопаточные каналы, движется 

сначала к центру, затем поворачивает в осевом направлении и, наконец, выходит из колеса 

под углом к оси, создавая вращающий момент. Так как при течении к центру вращающе-

гося колеса частицы рабочего тела испытывают противодействие центробежной силы, то 

межлопаточные каналы должны иметь определѐнную степень реактивности. 

 

Рис. 1.6. Радиально-осевая центростремительная турбина: 

1 — коллектор подвода; 2 — сопловой аппарат;3 — радиально-осевое колесо; 4, 5 — вы-

ходной и входной патрубки 

         Масса и габариты радиальной турбины обычно несколько больше, чем осевой, а на 

диск еѐ колеса действуют значительно большие осевые, температурные и центробежные 

нагрузки. Однако при больших отношениях U/Сад  КПД радиальной турбины выше, чем 

осевой. Кроме того, она проще в изготовлении и удобно компонуется в головке основной 

камеры двигателя. Поэтому радиальные турбины иногда используются в качестве предка-

мерных турбин ЖРД, а также жидкостных турбин, приводящих во вращение преднасосы.  
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2 МОДЕЛИРОВАНИЕ ГАЗОДИНАМИЧЕСКИХ ПРОЦЕССОВ  

В РАБОЧИХ  КОЛЁСАХ ТУРБИН ТНА 

Перед началом работы необходимо определить ось вращения, которая будет общей 

для всех моделей (газодинамической, тепловой, прочностной). Все дальнейшие построе-

ния будем выполнять в соответствии с этой осью и в одной системе координат так, чтобы 

в дальнейшем при сборке все модели соединялись без ошибок. Важной деталью в сопря-

жѐнном расчѐте является совпадение угловых секторов газодинамической и прочностной 

моделей. Затем на чертеже турбины необходимо определиться с расположением границ, 

разделяющих основной тракт турбины и притрактовые полости. На рисунке 2.1 показан 

алгоритм получения меридиональных обводов для основного тракта и притрактовых по-

лостей. Сначала необходимо определиться с областью моделирования и с границами при-

трактовых полостей, затем выбирается расположение разделяющих границы трактов, 

лишние линии удаляются, оставляя только границы основного тракта. После этого чертѐж 

основного тракта сохраняется в одном из универсальных форматов записи (*.iges, 

*parasolid.x_t). В чертѐж основного тракта турбины можно включить линию, которая бу-

дет границей между зонами соплового аппарата и рабочего колеса. 

 

Рис. 2.1. Схема получения меридиональных обводов основного тракта турбины 

Твѐрдотельные модели рабочего колеса и лопатки соплового аппарата турбины соз-

даются в любом CAD-редакторе и также сохраняются в одном из универсальных форма-

тов записи. 

Данная методика предназначена для пользователей, уже имеющих опыт работы с 

программными продуктами ANSYS, поэтому некоторые элементарные операции в тексте 

опущены. 
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2.1 Создание модели основного тракта турбины  

в DESIGN MODELER 

При создании расчѐтной сетки в универсальном сеткогенераторе требуется создание 

твѐрдотельной модели внутренней полости проточной части. Для построения твѐрдотель-

ной модели межлопаточного канала турбины используется CAD-редактор Design Modeler. 

Он является программным продуктом компании ANSYS и встроен в оболочку ANSYS 

Workbench.  

Шаг 1. Создание проекта в ANSYS Workbench. Необходимо запустить ANSYS Work-

bench сохранить проект (рис. 2.2). Внимание! Используйте в названии папок и файлов 

только латинские буквы или цифры.   

 

Рис. 2.2. Создание проекта в ANSYS Workbench 

Шаг 2. Добавляем в проект модуль Fluid Flow (CFX). Для этого перетягиваем мо-

дуль в рабочее поле. 

Шаг 3. Запускаем двойным щелчком по вкладке Geometry модуль Design Modeler. 

После загрузки необходимо выбрать миллиметры в качестве размерности величин по 

умолчанию (рис. 2.3). 
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Рис. 2.3. Выбор единиц измерения 

Шаг 3. Импорт меридиональных обводов основного тракта турбины. С помощью 

меню Import External Geometry File загрузить файл, содержащий меридиональные об-

воды газодинамического тракта (рис. 2.4). Для выполнения каждой операции в Design 

Modeler необходимо нажимать клавишу Generate . 

 

Рис. 2.4. Импорт меридиональных обводов турбины 

Шаг 4. Затем с помощью операции  Revolve (вращение) создаѐтся твѐрдотельная 

модель основного тракта турбины (рис. 2.5). 
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Рис. 2.5. Настройки меню вращения 

Шаг 5. Далее из полученного тела вращения вычитается объѐм сопловых лопаток 

турбины. Для этого в меню импорта указывается файл твѐрдотельной модели сопловой 

лопатки и выбирается опция: импорт с удалением материала (Cut Material) (рис. 2.6). 

 

Рис. 2.6. Настройки меню импорта с вычитанием геометрии 

 и результат операции 

Шаг 6. Аналогичным образом вычитается объѐм рабочих лопаток турбины. Резуль-

тат операции показан на рис. 2.7. 
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Рис. 2.7. Результат операции с вычитанием геометрии рабочих 

 лопаток турбины 

Шаг 7. С помощью операции вращения  разделительной линии, импортированной 

вместе с чертежом обводов, объѐм основного тракта разделяется на объѐмы межлопаточ-

ных каналов сопловых и рабочих лопаток турбины. Для этого выбирается опция с удале-

нием материала (Cut Material). Настройки меню импорта с вычитанием материала и  ре-

зультат операции показан на рис. 2.8. 

 

Рис. 2.8. Настройки меню вращения разделительной линии 

 с вычитанием геометрии и результат операции  

Шаг 8. Следующими выполняют несколько операций (шаг 8- 14), направленных на 

получение твѐрдотельной модели одного межлопаточного канала рабочего колеса турби-

ны, обладающего свойством окружной периодичности. Сначала в плоскости XY создается 

эскиз  тела-инструмента. С помощью дуги строится линия, проходящая через центр 

межлопаточного канала, затем с помощью прямых линий эскиз достраивается до вида, 

изображѐнного на рис. 2.9. Желательно, чтобы в границах эскиза оказалось не меньше 

двух межлопаточных каналов. 



28 

 
Рис. 2.9. Эскиз тела-инструмента, создаваемого для построения 

одного межлопаточного канала 

Шаг 9.  С помощью операции выдавливания (Extrude ) эскиз вытягивается на вы-

соту, превышающую периферийные обводы рабочего колеса (рис. 2.10). 

 
Рис. 2.10. Операция выдавливания тела-инструмента 

Шаг 10. Затем созданное тело инструмент проворачивается на некоторый неболь-

шой угол с помощью операции Body Operation . Угол поворота выбирается так, чтобы 

округлая плоскость тела-инструмента расположилась примерно  в  середине между сосед-

ними лопатками рабочего колеса турбины (рис. 2.11). 
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Рис. 2.11. Поворот тела-инструмента 

Шаг 12. Выполняется булева операции (Boolean ) пересечения (Intersect) для те-

ла-инструмента и объема межлопаточного пространства рабочего колеса (рис. 2.12). 

 
Рис. 2.12. Булева операция над телами 

Шаг 12. Повторяется шаг №9. 

Шаг 13. Созданное тело-инструмент №2 поворачивается на угол, равный угловому 

сектору одного межлопаточного канала, относительно угла поворота тела-инструмента 

№1 (рис. 2.13). Другими словами, угол между двумя телами-инструментами должен быть 

равен углу периодичности лопаточного венца. 
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Рис. 2.13. Настройки меню операций с телами и результат операции 

Шаг 14. С помощью булевой операции Boolean  тело-инструмент №2 вычитается 

из объѐма межлопаточного пространства рабочего колеса (рис. 2.14). 

 
Рис. 2.14. Полученная модель межлопаточного канала рабочего колеса турбины 

Созданная модель одного межлопаточного канала обладает свойством окружной пе-

риодичности, а переход от полноокружной модели рабочего колеса турбины к секторной 

позволяет существенно сократить вычислительные затраты. 
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Шаг 15. Создание новой вспомогательной плоскости с помощью команды New Plane 

 (рис. 2.15). 

 
Рис. 2.15. Создание новой вспомогательной плоскости 

Шаг 16. В новой плоскости создается эскиз  тела-инструмента для соплового ап-

парата. С помощью дуги строится линия, проходящая через центр межлопаточного кана-

ла, затем с помощью прямых линий эскиз достраивается до вида, изображѐнного на ри-

сунке 2.16. Желательно, чтобы в границах эскиза оказалось не меньше двух межлопаточ-

ных каналов. 

 

Рис. 2.16. Создание новой вспомогательной плоскости 
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Шаг 17. Далее выполняется аналогичный ряд операций (шаги 9- 14) для получения 

твѐрдотельной модели одного межлопаточного канала соплового аппарата. Результат 

представлен на рисунке 2.17. 

 

Рис. 2.17. Построенная секторная модель основного тракта основной турбины 

Шаг 17. Далее необходимо исключить из работы линии меридиональных обводов 

основного тракта с помощью операции Suppress Body  (рис. 2.18).  

 

Рис. 2.18. Выключение из дальнейшего расчѐта линий 

На этом операция по подготовке твѐрдотельной модели завершается, далее осущест-

вляется непосредственно процесс построения расчѐтной сетки. 
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2.2 Создание на основе твѐрдотельной модели тракта сеточной модели  

в ANSYS MESHING 

Запуск программы ANSYS Meshing осуществляется из-под оболочки  

ANSYS Workbench двойным щелчком по вкладке Mesh. После загрузки приложения в него 

автоматически подгружается геометрия, созданная в CAD-редактор Design Modeler. 

Для облегчения построения расчетной сетки использовался стандартный алгоритм 

создания неструктурированной сетки со сгущением и упорядочиванием поверхностных 

сеток. Для увеличения количества элементов в пристеночной зоне используется функция 

по созданию призматического слоя 

Шаг 1. Сначала с помощью операции инфляции (Inflation )создается призматиче-

ский слой на втулочных и периферийных поверхностях объема межлопаточного канала 

соплового аппарата. Для создания призматического слоя указывается объект на который 

будет распространяться сгущение, объект от которого будет распространяться сгущение, а 

также настройки сгущения (толщина слоя, количество слоев и др.). На рисунке 2.19 пока-

заны настройки меню создания призматического слоя и грани, вблизи которых он созда-

ется. 

 

Рис. 2.19. Настройка создания призматического слоя вблизи обводов соплового 

аппарата 

Шаг 2. По аналогии с предыдущей операцией призматический слой создается на по-

верхностях лопатки соплового аппарата (рис. 2.20) и на втулочных, периферийных и по-

верхностях пера лопатки объема рабочего колеса турбины (рис. 2.21). 
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Рис. 2.20. Настройка создания призматического слоя  

вблизи пера лопатки соплового аппарата 

 
Рис. 2.21. Настройка создания призматического слоя  

вблизи пера лопатки и обводов рабочего колеса 

Шаг 3. Для повышения качества сетки на отдельных гранях используется функция 

упорядочивания сеточных элементов (Mapped Face Meshing ). Для упорядочивания не-

обходимо указать грани на границе объема соплового аппарата и рабочего колеса турбины 

и грани на границе объема рабочего колеса с притрактовыми полостями (рис. 2.22). 

 
Рис. 2.22 Настраивание упорядочивания сетки на отдельных гранях 

Шаг 4. Алгоритм сеткогенератора не всегда может корректно определить необходи-

мый размер элементов и их количество на грань, поэтому пользователю доступен специ-

альный инструмент, позволяющий указывать необходимые параметры сеточных элемен-

тов применительно к линиям, поверхностям и объемам. С помощью операции по указа-
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нию размера сеточного элемента (Face Sizing ) необходимо увеличить количество эле-

ментов на границе интерфейса объема соплового аппарата (рис. 2.23), на границах интер-

фейсов между объемом рабочего колеса и притрактовыми полостями (рис. 2.24). В на-

стройках меню указываются размер элемента и поверхности, для которых он задается. 

 
Рис. 2.23. Настройки меню указания размера элемента 

на выходной грани объема соплового аппарата 

 
Рис. 2.24. Настройки меню указания размера элемента на гранях  

интерфейса объѐмов рабочего колеса и притрактовых полостей 

Шаг 5. Для повышения качества сетки необходимо увеличить количество элементов 

на грани вблизи интерфейса втекания за рабочей лопаткой турбины. Для этого на этой 

грани устанавливается маленький размер сеточного элемента. Настройки меню указаны на  

рисунке 2.25. 
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Рис. 2.25. Настройки меню указания размера элемента на грани  

вблизи интерфейса объѐмов рабочего колеса и притрактовой полости 

После этого процесс настройки сетки завершен. Далее необходимо выделить грани 

модели к которым в препроцессоре будут применяться какие-либо граничные условия: 

входа, выхода, интерфейсы. Для облегчения работы при обработке результатов расчета 

необходимо также выделить поверхности окружных обводов: втулочных и периферий-

ных, поверхности лопаток и боковые грани для моделей межлопаточных каналов соплово-

го аппарата и рабочего колеса турбины. При этом грани расчетной модели, которые будут 

использоваться для передачи граничных условий для прочностного анализа необходимо 

именовать особо (например name*_p). Если грань относится к поверхности периферийно-

го обвода рабочего колеса (shroud), но также будет использоваться для передачи данных в 

прочностной модуль, то ее рекомендуется назвать shroud_p.  

Шаг 6. Процесс выделения грани происходит с помощью операции присваивания 

имени (Named Selection ) из контекстного меню. В таблице 2.1 приведены названия со-

ответствующих границ модели. 

Таблица 2.1. Настройка входного граничного условия 

Граничное условие Название в программе 

Вход в домен СА  inlet 

Выход домена РК outlet 

Периферийные поверхности домена СА ca shroud 

Втулочные поверхности домена СА ca hub 

Поверхность лопатки СА ca blade 

Левые боковые грани домена СА ca per1 

Правые боковые грани домена СА ca per2 

Выход домена СА ca to rk_1 

Вход домена РК ca to rk_2 

Поверхность лопатки РК rk blade_p 

Втулочные поверхности домена РК (за исключением по-

верхностей интерфейсов)  

rk hub_p 

Периферийные поверхности домена РК (за исключением 

поверхностей интерфейсов) 

rk shroud_p 

Поверхности касающиеся бандажа РК rk bаnd_p 

Левые боковые грани домена РК rk per1 

правые боковые грани домена РК rk per2 

Поверхность интерфейса на втулке перед РК vtekanie1 

Поверхность интерфейса на втулке за РК vtekanie2 

Поверхность интерфейса на периферии перед РК band1 

Поверхность интерфейса на периферии за РК band2 
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На рисунке 2.26 представлены выделенные грани и их названия.  

 

Рис. 2.26. Выделенные границы модели и их названия 

Шаг 7. Создание расчетной сетки. После нажатия кнопки обновления (Update ) 

запускается процесс сеткогенерации. По окончании которого в графическом окне появля-

ется сгенерированная расчетная сетка, а под ним появляется окно статистики, отобра-

жающее гистограмму распределение количества элементов по выбранному критерию ка-

чества сетки. Традиционным критерием качества сетки является ее скошенность 

(Skewness) (рис. 2.27). Этот параметр прямо пропорционален разнице наибольшего и наи-

меньшего углов в ячейке, и обратно пропорционален наибольшему углу. Диапазон изме-

рения этого параметра от 0 до 2. Наибольшее значение этого параметра соответствует 

наименее качественным ячейкам.  
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Рис. 2.27. Просмотр качества созданной расчѐтной сетки 

Для просмотра расположения элементов с высокой скошенностью необходимо ЛКМ 

щелкнуть по столбцу гистограммы. В элементах с высокой скошенностью возникают 

большие расчетные ошибки влияющие как на сам процесс решения, так и на результаты 

расчета в целом. При создании расчетной сетки пользователю необходимо стремиться 

снизить максимальную скошенность ячеек ниже 0,97, используя средства управления сет-

кой, описанные выше. 

На этом работа по созданию расчетной сетки основного тракта турбины закончена. 
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2.3 Настройка расчѐтной модели основного тракта турбины в ANSYS CFX-PRE 

В препроцессоре настраиваются свойства рабочего тела, граничные условия, зада-

ются настройки различных моделей турбулентности, настраиваются параметры решателя, 

а также вывод справочных данных во время расчета по которым оценивается степень 

схождения задачи. Далее подробно описываются этапы построения расчетной модели. 

Шаг 1. Запуск программы ANSYS CFX-Pre осуществляется из-под оболочки ANSYS 

Workbench двойным щелчком по вкладке Setup. После загрузки приложения в него авто-

матически подгружается сеточная модель, созданная в сеткогенераторе Ansys Meshing.  

Шаг 2. В меню типа анализа (Analysis Type ) выбирается режим стационарного 

расчета течения (Steady State). Расчет в стационарной постановке позволяет существенно 

сократить потребные вычислительные и временные ресурсы, обеспечивая при этом доста-

точную точность решения.  

Шаг 3. После этого необходимо создать новое рабочее тело, которое по своим свой-

ствам соответствует реальному рабочему телу в основной турбине ТНА. Для этого в дере-

ве модели во вкладке Materials создается новое рабочее тело: GeneratorGas со свойствами, 

описанными в таблице 2.2 (рис. 2.28). 

Таблица 2.2. Термофизические свойства генераторного газа 

Name  GeneratorGas 

Вкладка Basic Settings 

Material Group Calorically Perfect Ideal Gases 

Termodynamic State Gas 

Вкладка Materials Properties 

Термодинамические свойства  Изменяются по закону идеального газа  

Молярная масса 31,95 кг/кмоль 

Теплоемкость 1048,8 Дж/кг*К 

Динамическая вязкость  0,00001831 кг/м*с 

Теплопроводность 0,0261 Вт/м*К 



40 

 

Рис. 2.28. Создание и настройка рабочего тела 

Шаг 4. Затем, используя меню Domain  на панели быстрого доступа выделяются 

домены (расчетные зоны) соплового аппарата (CA). Для удобства в дальнейшем называть 

домены следует по имени узла ТНА, которому они соответствуют. Следует отметить, что 

алгоритм работы CFX адресный, поэтому создание двух одинаковых имен, например, для 

домена и границы невозможно. 

 

Рис. 2.29. Настройка домена и моделей решения 

В меню настройки расчетных зон также настраиваются модели, используемые в рас-

чете (рис. 2.29): выбирается рабочее тело, модель турбулентности и модель тепловых про-

цессов. Настройки используемых в расчете моделей автоматически применяются ко всем 
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доменам проекта. После выделения домена соплового аппарата (СА), необходимо выпол-

нить выбор используемых моделей. Во вкладке Basic Settings выбирается рабочее тело 

GeneratorGas, устанавливается равным нулю справочное давление (Reference Pressure), 

также в подменю  Domain Motion указывается тип домена – стационарный. Во вкладке 

Fluid Models необходимо включить учет теплообмена: во вкладке Heat Transfer выбрать 

Total Energy. Здесь же выбирается модель турбулентности и ее настройки в подменю Tur-

bulency: модель турбулентности k-Epsilon, и функции стенки Scalable Wall Function. Мо-

дель турбулентности k-Epsilon является наиболее универсальной, обладает широкой обла-

стью применения и достаточно хорошо апробирована в инженерных расчетах [11]. 

Шаг 5. Создание домена рабочего колеса турбины. Настройка домена аналогична 

настройке домена соплового аппарата. При создании домена рабочего колеса турбины, 

дополнительно в его настройках указывается угловую скорость (об/мин) и ось вращения 

(рис. 2.30). Причем положительное значение угловой скорости указывается, если враще-

ние происходит по движению часовой стрелке в направлении оси вращения (правило пра-

вой руки), а отрицательное соответственно, когда против движения часовой стрелки. 

 

Рис. 2.30. Настройки свойств домена рабочего колеса турбины 

Шаг 6. После создания доменов на их поверхности накладываются граничные усло-

вия. Граничные условия (ГУ) задаются с помощью меню Boundary , в них указываются 

поверхность для которой оно применяется, тип ГУ, а также значение параметров потока в 

соответствии с выбранным типом ГУ (рис. 2.31). На тех гранях расчетной модели, для ко-

торых не будет определено специальное ГУ, по умолчанию задается ГУ адиабатной не-

проницаемой стенки. Параметры ГУ входа приведены в табл. 2.3. 
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Рис. 2.31. Настройка граничного условия на входе в расчетную модель 

Таблица 2.3. Параметры входного граничного условия 

Name  inlet 

Вкладка Basic Settings 

Boundary Type выбирается тип Inlet 

Location 
выбирается входная грань домена со-

плового аппарата 

Вкладка Boundary Details 

Flow Regime Subsonic 

Mass And Momentum Option Total Pressure (stable) 

Relative Pressure 3.25187e+07 (Pa) 

Flow Direction Option Normal to Boundary Condition 

Turbulence Option Medium (Intensity=5%) 

Heat Transfer Option Total Temperature 

Total Temperature 654 K 

Первый расчет необходимо проводить не небольшом перепаде давления, с тем, что-

бы решение установилось. Последующий расчет запускается уже на расчетном перепаде с 

инициализацией с предыдущего решения.  

Шаг 7. Аналогично предыдущему шагу создается граничное условие на выходе мо-

дели в домене рабочего колеса турбины (RK) (табл. 2.4). 
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Таблица 2.4. Настройка выходного граничного условия 

Name  outlet 

Вкладка Basic Settings 

Boundary Type выбирается тип Outlet 

Location 
выбирается выходная грань домена ра-

бочего колеса турбины 

Вкладка Boundary Details 

Flow Regime Subsonic 

Mass And Momentum Option Average Static Pressure 

Relative Pressure 3.00197e+07 (Pa) 

Pres. Profile Blend 0.05 

Pressure Averaging Option Circumferential 

Следующим шагом необходимо выделить границы, которые понадобятся для удоб-

ства обработки результатов расчета, а также будут использованы в прочностном анализе. 

В постпроцессоре CFD-Post встроен специальный модуль для работы с турбомашинами 

(Turbo Mode), который после привязки к конкретной геометрии лопаточной машины по-

зволят использовать специальный инструменты для обработки результатов расчета (стро-

ить поверхности по относительной высоте и длине канала, выводить графики параметров 

потока по сечениям пера лопатки и др.). Для привязки к геометрии лопаточного венца в 

модуле используется инициализация поверхности втулочного и периферийного обводов, 

поверхности пера лопатки и боковых периодичных граней. Для корректной работы данно-

го механизма указанные грани в препроцессоре необходимо назвать специальным обра-

зом: втулочный обвод – hub, периферийный обвод – shroud, поверхность лопатки – blade.  

Шаг 8. В домене соплового аппарата создать граничное условие стенки для втулоч-

ных поверхностей CA_hub (рис. 2.32).  

 
Рис. 2.32. Меню граничного условия непроницаемой стенки  

на поверхностях втулочного обвода соплового аппарата 
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Шаг 9. Аналогично шагу №8 создается граничное условие стенки на периферийной 

поверхности домена соплового аппарата CA_shroud (рис. 2.33). 

 

Рис. 2.33. Меню граничного условия непроницаемой стенки  

на поверхностях периферийного обвода соплового аппарата 

Шаг 10. Аналогично шагу №9 создается граничное условие стенки на поверхностях 

пера лопатки домена соплового аппарата CA_blade (рис. 2.34). 

 

Рис. 2.34 Меню граничного условия непроницаемой стенки 

на поверхностях пера лопатки соплового аппарата 

Шаг 12. Создание граничного условия непроницаемой стенки на втулочной поверх-

ности домена рабочего колеса. Дополнительно для поверхностей домена рабочего колеса, 

которые будут использованы в прочностном анализе (втулочная поверхность, поверхность 

пера лопатки, поверхности вблизи бандажа), необходимо в имя добавить *_p, для облече-

ния работы в дальнейшем (рис. 2.35-2.38). 

 

Рис. 2.35 Меню граничного условия непроницаемой стенки на поверхностях втулоч-

ного обвода рабочего колеса 
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Шаг 12. Создание граничного условия непроницаемой стенки на периферийной по-

верхности домена рабочего колеса. 

 

Рис. 2.36. Меню граничного условия непроницаемой стенки  

на поверхностях периферийного обвода рабочего колеса 

Шаг 12. Создание граничного условия непроницаемой стенки на периферийной по-

верхности домена рабочего колеса. 

 

Рис. 2.37. Меню граничного условия непроницаемой стенки  

на поверхностях пера лопатки рабочего колеса 

Шаг 13. Создание граничного условия непроницаемой стенки на поверхности бан-

дажа домена рабочего колеса (рис. 2.38). 

 

Рис. 2.38. Меню граничного условия непроницаемой стенки  

на поверхности бандажа рабочего колеса 

Для передачи данных между отдельными расчетными зонами служат специальные 

граничные условия проницаемости - интерфейсы (Interfaces ). Они позволяют переда-
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вать данные между вращающимся и неподвижным доменами, между доменами с разным 

углом сектора и т.д.  

Шаг 14. Создать интерфейс между доменами соплового аппарата (СА) и рабочего 

колеса (RK) турбины с помощью меню настройки интерфейса (Interfaces ) (рис. 2.39).  

 

Рис. 2.39. Меню настройки свойств интерфейса расчѐтной модели 

Для настройки интерфейса между доменами необходимо ввести данные табл. 2.5. 

Таблица 2.5. Параметры интерфейса между доменами 

Name  ca to rk 

Вкладка Basic Settings 

Interface Type выбирается тип Fluid Fluid 

Interface Side 1 домен соплового аппарата (СА) 

Region List Выходная грань домена соплового аппарата 

Interface Side 2 домен рабочего колеса (RK) 

Region List Входная грань домена рабочего колеса 

Interface Models Option General Connection 

Frame Change/Mixing Model Option Stage 

Pitch Change Option Value 

Pitch Ratio 25/36 

 

Параметр Pitch Ratio обозначает соотношение углов секторов сопряженных доменов. 

Так как в лопаточных машинах угол периодичного сектора обычно напрямую связан с 

числом лопаток, для интерфейса между доменами соплового аппарата турбины и рабочего 

колеса турбины Pitch Ratio равен 25/36 (по числу лопаток в лопаточных венцах: 25 лопа-

ток в сопловом аппарате и 36 лопаток в рабочем колесе). 
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После создания интерфейса в графическом окне на границах расчетных моделей, 

выбранных проницаемыми, появляются специальные символы в виде зеленых конусов. 

Так как лопаточные венцы моделируются с помощью одного межлопаточного кана-

ла, то необходимо настроить граничное условие периодичности.  

Шаг 15. Для создания ГУ периодичности также используется меню Domain Interface 

(рис. 2.40). Для настройки периодичности домена домена СА необходимо ввести данные 

табл. 2.6.  

Таблица 2.6. Настройка интерфейса периодичности 

Name  ca_per 

Вкладка Basic Settings 

Interface Type выбирается тип Fluid Fluid 

Interface Side 1 домен соплового аппарата (СА) 

Region List выбирается левая боковая грань домена 

Interface Side 2 домен соплового аппарата (СА) 

Region List 
выбирается правая боковая грань доме-

на 

Interface Models Option Rotational Periodicity 

Axis Definition Option Coordinate Axis 

Rotational Axis Global X 

После задания соответствующих граничных условий в графическом окне препроцес-

сора на модели появляются маркеры, которые могут помочь определить грани на которые 

наложены граничные условия периодичности. 

 

Рис. 2.40. Меню настройки граничного условия периодичности 



48 

Шаг 16. Аналогично шагу №15, необходимо создать периодические граничные ус-

ловия и для домена рабочего колеса турбины (рис. 2.41). 

 

Рис. 2.41. Настройка ГУ периодичности домена рабочего колеса турбины 

Затем необходимо настроить опции решателя. Настройка осуществляется в дереве 

проекта во вкладке Solver , Solver Control . Здесь указываются схема решения, по-

рядок точности, критерии остановки расчета (максимальное количество итераций, по-

требный уровень невязок), а также вводятся настройки масштаба времени моделирования 

(Timescale Control). В основном используются два варианта задания временного шага: ав-

томатический (Auto Timescale Control) и фактический (Physical Timescale Control). При ав-

томатическом режиме решатель сам определяет масштаб временного шага, а пользователь 

может лишь менять множители (Timescale Factor) коэффициента временного шага. При 

фактическом режиме пользователь непосредственно указывает протяженность процесса 

во времени в секундах. При первых расчетах газодинамической модели необходимо ис-

пользовать пониженные значения временного шага, чтобы избежать расхождения реше-

ния. 

Шаг 17. Настройка параметров решателя (рис. 2.42). Рекомендуемые настройки ре-

шателя показаны ниже: 

Таблица 2.7. Настройка опций решателя 

Advection Scheme Option High Resolution 

Turbulence Numerics Option High Resolution 

Convergence Control Max. Iterations 1500 

Timescale Control Auto Timescale Control 

Timescale Factor 0.01 

Convergence Criteria Residual Target 0.000001 
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Рис. 2.42. Настройка параметров решателя 

При моделировании турбулентных течении в каналах сложно формы, к которым от-

носятся турбомашины, стандартный критерий схождения решения - значение невязок, за-

частую недостаточен. Оценку схождения решения удобно проводить по графику измене-

ния интегральных параметров потока во время расчета. Если решение установилось, то 

значение интегрального параметра потока меняться не будет, или будет меняться со стро-

гой цикличностью. Для модели рабочего процесса турбины таким интегральным парамет-

ром удобно принять значения степени понижения давления в турбине (πт). Для того чтобы 

в процессе решения была возможность отслеживать изменения интересующих параметров 

необходимо в меню выражений (Expressions ) создать переменные позволяющие рас-

считывать интересующие нас параметры. 

Шаг 18. Создать выражение, вычисляющее значение степени понижения давления 

(рис. 2.43). Выражения записывается во вкладке Definition согласно таблице 2.8. 

Таблица 2.8. Выражение интегрального параметра потока: степени понижения 

давления в турбине 

Название 

выражения 
Описание выражения (в одну строку) 

Pit 
massFlowAve(Total Pressure in Stn Frame) 

@inlet/massFlowAve(Total Pressure in Stn Frame)@outlet 
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Рис. 2.43. Запись пользовательского выражения 

Шаг 19. Необходимо перейти в настройки Solver , вкладка Output Control . 

Дальше необходимо перейти во вкладку Monitor и активировать функцию Monitor Objects. 

Затем перейти в меню Monitor Points and Expressions .Здесь необходимо создать новые пе-

ременные для отображения. С помощью иконки  создаем переменную (название пере-

менной не должно полностью совпадать с названием соответствующего выражения), вы-

бираем в Option Expression и вводим имя соответствующего ему выражения (рис. 2.44). 

 

Рис. 2.44. Внешний вид меню Output Control 

Шаг 20. Сохраняем расчетную модель с помощью иконки  на панели быстрого 

доступа. На этом настройка расчетной модели турбины ТНА завершена. 
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2.4 Расчѐт и анализ полученных результатов 

Запуск решателя ANSYS CFX-Solver Manager осуществляется из-под оболочки ANSYS 

Workbench двойным щелчком по вкладке Solution. После загрузки приложения в него ав-

томатически подгружается расчетная модель, созданная в препроцессоре Ansys CFX-Pre.  

Шаг 2. Для использования режима распараллеливания необходимо выбрать метод 

HP MPI Local Parallel с указыванием числа доступных для работы ядер процессора вы-

числительной машины (рис. 2.45).  

 

Рис. 2.45. Меню запуска расчѐта 

Для запуска расчета нажимаем клавишу Start Run. 

После запуска решателя в процессе счета автоматически будут отображаться поль-

зовательские переменные в окне User Points (рис. 2.46). 

 

Рис. 2.46. Характер изменения пользовательских переменных во время расчѐта 
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После того как невязки начали снижаться (примерно 200-300 итераций), необходимо 

перейти к плавному повышению коэффициента временного шага, с тем чтобы завершать 

расчет на максимально возможном устойчивом значении коэффициента (обычно 10). По-

вышать значение временного шага рекомендуется не больше чем в 10 раз за одну опера-

цию. Повышение временного шага приводит к снижению времени вычисления, но на на-

чальных этапах может привести к развалу решения.  

Шаг 2. Процесс повышения временного шага осуществляется с помощью операции 

Dynamically edit setting of the run in progress . Алгоритм динамического изменения на-

строек решателя изображен на рисунке 2.47. При закрытии меню необходимо сохранить 

изменения, чтобы они вступили в силу. 

 
Рис. 2.47. Изменение шага по времени во время расчѐта 

В процессе решения необходимо следить не только за поведением невязок стандарт-

ных параметров, но и за невязками интегральных параметров (рис. 2.48). После установ-

ления решения при максимальных рекомендованных значениях временного шага невязки 

находятся в районе значения 10
-4

…10
-5

 , а интегральные параметры уже не меняются. 

 
Рис. 2.48. Изменение невязок во время расчѐта 
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Завершение расчета происходит автоматически по достижении указанного числа 

итераций, либо заданного значения невязок. Для принудительной остановки расчета мож-

но воспользоваться иконкой . По завершении расчета автоматически создается файл 

результатов (*.res). После этого необходимо провести следующий расчет на потребном 

перепаде давления в турбине. 

Шаг 3. Необходимо вернуться в препроцессор и изменить значение статического 

давления на выходной границе турбины равным 15.5 МПа, что соответствует расчетному 

перепаду давления в турбине (рис. 2.49). 

 

Рис. 2.49. Изменение граничного условия на выходе турбины 

 После изменения граничного условия необходимо заново произвести расчет, для 

получения решения на заданном режиме работы турбины.  

Шаг 4. Произвести новый расчет на потребном перепаде давления. Также используя 

динамическое изменение масштаба временного шага. 

 Для обработки результатов расчета необходимо перейти в постпроцессор CFD- Post. 

Запуск постпроцессора ANSYS CFD-Post осуществляется из-под оболочки ANSYS 

Workbench двойным щелчком по вкладке Results. После загрузки приложения в него авто-

матически подгружаются результаты расчета. После запуска постпроцессора появляется 

окно Domain Selector где есть возможность выбрать домены необходимые для работы. 

Для обработки результатов расчетов турбомашин в CFD Post предусмотрен специ-

альный режим Turbo (рис. 2.50). Для работы в этом режиме необходимо перейти во вклад-

ку Turbo и выполнить распознавание элементов соплового аппарата. При распознавании 

лопаточных машин постпроцессор определяет поверхности втулочного и периферийного 

обводов, а также поверхность лопатки. Это нужно для построения осредненных полей в 

меридиональной и осевой плоскостях.  

При корректном выполнении инициализации в графическом окне появляется мери-

диональное сечение домена, осредненное в окружном направлении.  

Шаг 5. Необходимо провести распознавание домена рабочего колеса (рис. 2.51). 
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Рис. 2.50. Меню режима работы с турбомашинами (вкладка Turbo) 

 

Рис. 2.51. Распознавание элементов домена рабочего колеса (вкладка Turbo) 
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В режиме работы с турбомашинами доступны различные способы визуализации па-

раметров потока: 1) отображение полей распределения параметров потока в окружной 

плоскости в различных сечениях по высоте проточной части (Blade-to-Blade); 2) отобра-

жение полей распределения параметров потока в меридиональной плоскости (Meridional); 

3) отображение графиков распределения параметров потока по высоте проточной части 

(Hub to Shroud), по длине канала от входа к выходу (Inlet to Outlet), по перу лопатки (Blade 

Loading) и окружное распределение на определенной высоте канала (Circumferential). 

Шаг 6. После выполнения распознавания элементов лопаточных машин, необходи-

мо просмотреть поле относительной скорости на срединном сечении (рис. 2.52), а также 

распределение векторов относительной скорости потока (рис. 2.53). 

 
Рис. 2.52. Отображение поля относительной скорости потока 
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Рис. 2.53. Отображение векторов относительной скорости потока 

Для получения интегральных параметров потока в модели турбины ТНА, а также 

определения направления течения потока необходимо знать средние значения параметров 

потока в характерных сечениях. Для этого в CFD Post предусмотрена функция калькуля-

тора (Calculators). Список доступных функций для расчета параметров на границах рас-

четной модели представлен в таблице 2.9. 

Таблица 2.9. Доступные функции калькулятора CFD Post 

Название Описание  Название Описание 

area площадь  massFlow массовый расход 

areaAve средний по площади  massFlowAve осредненный по массовому расходу 

Ave осредненный  maxVal максимальное значение 

count число узлов  minVal минимальное значение 

force сила  torque момент 

lenght длина  volume объем 

lenghtAve средний по длине  volumeAve осредненный по объему 
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Шаг 7. Для определения среднего значения давления потока на лопатки рабочего 

колеса необходимо в меню Function Calculator выбрать осреднение по площади, затем по-

верхность лопатки из выпадающего меню и указать параметр потока давление (рис. 2.54). 

 
Рис. 2.54. Меню Function Calculator 

Шаг 8. Затем необходимо просмотреть поля давлений на лопатках для определения 

сильно нагруженных мест (рис. 2.55). Для того необходимо перейти во вкладку Outline, 

затем добавить элемент просмотра полей параметров Contour .  

 
Рис. 2.55. Просмотр поля распределения давления 
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3 МОДЕЛИРОВАНИЕ ГАЗОДИНАМИЧЕСКИХ И ТЕПЛОВЫХ  

ПРОЦЕССОВ В ПРИТРАКТОВЫХ ПОЛОСТЯХ ТУРБИНЫ 

В классической постановке для расчѐта теплового состояния рабочего колеса основ-

ной турбины турбонасосного агрегата необходимо предварительно рассчитать параметры 

конвекции в полостях, граничащих с ним.  

В данном случае в рабочем колесе турбины можно выделить следующие полости и 

поверхности, в которых необходимо определить коэффициенты теплоотдачи и температу-

ры рабочего тела (рис. 3.1): 

 передняя полость между диском и корпусом (1); 

 задняя полость между диском и корпусом (2); 

 полость ограниченная бандажной полкой и статором (3); 

 поверхность лопатки турбины (4); 

 поверхность периферии лопатки (5); 

 поверхность втулки диска (6). 

 

Рис. 3.1. Полости турбины ТНА: 1 - передняя полость между диском и корпусом; 

2 - задняя полость между диском и корпусом; 3 - полость ограниченная бандаж-

ной полкой и статором; 4 - поверхность лопатки турбины; 5 - поверхность пери-

ферии лопатки; 6 - поверхность втулки диска 

 

 Современные программные комплексы CFD, такие как CFX и Fluent, позволяют 

проводить сопряжѐнный анализ газодинамики и теплообмена. Поэтому, для проведения 

расчѐта в такой постановке, к газодинамической модели проточной части необходимо до-

бавить газодинамические модели притрактовых полостей (1, 2, 3 на рис. 3.1) и модель 

твѐрдого тела рабочего колеса турбины.  
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3.1 Создание геометрии притрактовых полостей и рабочего колеса 

Необходимо создать геометрические объѐмные модели притрактовых полостей и ра-

бочего колеса турбины. Поскольку результаты сопряжѐнного расчѐта далее будут исполь-

зоваться в анализе напряжѐнно-деформированного состояния, необходимо, чтобы поверх-

ности газодинамической области полностью совпадали с поверхностями твѐрдого тела. 

Это необходимость вызвана процессом  передачи  давления через FSI. 

Шаг 1. Добавление нового компонента в проект ANSYS Workbench. Прежде всего, 

для добавления описанных выше областей рекомендуется создать новый компонент Mesh. 

Создание нового компонента происходит путѐм перетаскивания Mesh в основное окно 

проекта из панели инструментов Component Systems (рис. 3.2) или вызовом контекстного 

меню нажатием правой кнопкой мыши в пустом месте основного окна, и выбором Mesh в 

выпадающем списке New Component Systems. 

 

Рис. 3.2. Добавление нового компонента в проект 

Шаг 3. Для создания или импорта геометрической модели необходимо войти во 

вкладку Geometry (рис. 3.3, а) и далее выбрать единицу измерения длины (рис. 3.3, б). 

           
а     б 

 

Рис. 3.3. Вход в DesignModeler:  

а - щелчок на элементе Geometry, б - выбор единиц измерения 
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Шаг 3. Создание объѐмной модели происходит непосредственно в Ansys Workbench, 

либо в любом другом CAD пакете, в котором он сохраняется в читаемый формат для 

Workbench. Импорт геометрии осуществляется следующем путѐм ГМ: File > Import Ex-

ternal Geometry File ...  

Шаг 4. Запуск генерации геометрии осуществляется командой . 

Шаг 5. Далее рекомендуется для каждого твѐрдого тела указать его тип (рис. 3.4). 

 

Рис. 3.4. Указание типа тела 
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3.2 Построение конечно-элементной сетки 

Шаг 1. Геометрическая модель разбивается на конечные элементы в модуле 

Meshing. Запуск модуля ANSYS Mesh осуществляется двойным щелчком по Mesh. Гео-

метрическая модель, созданная в DesignModeler, автоматически подгружается при запуске 

модуля. 

Шаг 3. В окне Details of «Mesh» в разделе Defaults необходимо выставить Physics 

Preference – CFD и Solver Preference – CFX (рис. 3.5). 

 

Рис. 3.5. Настройка параметров Mesh 

Шаг 3. В Details of ―Mesh‖ определяются общие параметры сетки. В разделе Sizing 

необходимо определить размер элемента (рис. 3.6). 

 

Рис.3.6. Задание размера элемента 

Шаг 4. Параметры сетки определяются во вкладке Mesh. Для этого необходимо еѐ 

выбрать и в любом месте окна нажать правую кнопку мыши (рис. 3.7). Возможные сред-

ства определения параметров сетки находятся во вкладке Insert. 



62 

 

Рис. 3.7. Определение параметров сетки 

Для определения размера элемента только рабочего колеса ТНА, необходимо во 

вкладке Insert выбрать  . Далее требуется выбрать тело рабочего колеса и задать 

размер элемента (рис. 3.8). 

 

Рис.3.8. Задание размера элемента рабочего колеса 

Шаг 5. Поскольку расчѐт проводится на секторе модели, необходимо чтобы сетка на 

гранях симметрии совпадала. Этого можно достичь при помощи команды Match Control. 

Но прежде необходимо создать цилиндрическую систему координат с осью вращения Z 

(рис. 3.9). 
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а 

 
б 

Рис. 3.9. Создание цилиндрической системы координат: а - вставка, б - настройка 

Шаг 6. В функции Match Control необходимо определить грани циклической сим-

метрии, тип Transformation - Cyclic и выбрать созданную цилиндрическую систему коор-

динат (рис. 3.10). 

 

Рис. 3.10. Параметры Match Control 

Шаг 7. Построение структурированной сетки методом Sweep на притрактовых газо-

динамических областях (рис. 3.11). Поскольку на областях Fluid будет создаваться при-
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стеночное сгущение сетки КЭ, необходимо выбрать грани источника Source, откуда будет 

происходить выдавливание. 

    

 

Рис. 3.11. Настройки функции Sweep 

Шаг 8. В газодинамических моделях для корректного учѐта взаимодействия потока 

со стенками необходимо построить пристеночный слой. Данное сгущение сетки строится 

с помощью команды Inflation (рис. 3.12а). Поскольку сетка будет строиться методом 

Sweep инфляцию необходимо определить на ребрах, принадлежащих граням, определѐн-

ных в параметрах Sweep как Source.  

В Details of ―Inflation‖ необходимо определить параметры пристеночного слоя, такие 

как, например, количество слоѐв и степень роста или другие (рис. 3.12б). 

       

а     б 

Рис. 3.12. Функция Inflation: а - вставка, б - настройка 
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Шаг 9. После определения всех параметров сетки необходимо нажать кнопку 

 и сгенерировать конечно-элементную модель (рис. 3.13). 

 

Рис. 3.13. Конечно-элементная модель сектора камеры сгорания 

Шаг 10. Проверка качества сетки. Это осуществляется в Details of ―Mesh‖ в разделе 

Statistics. 

 Наиболее важными факторами сетки для решателя являются: 

- Skewness (скошенность), определяется для quad и hexa сеток по следующей фор-

муле 

max e e min

e e

Skewness max ,
180

    
  

   , 

где e
 составляет для quad и hexa элементов составляет 90. Идеальная величина 0. 
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-Aspect Ratio (соотношение сторон), равное отношению длиной стороны элемента к 

короткой стороне (идеальная величина – 1). 

 Рекомендуются следующие ограничения для данных факторов: 

- Для Skewness: 

 Для Hexa, Tri и Quad: должен быть меньше 0.8 

 Для tetrahedral: должен быть меньше 0.9. 

 Необходимо стараться держать максимальное значение skewness менее 0.95. 

- Для Aspect Ratio: 

 Должен быть меньше 40, но это зависит от характеристик потока 

 Больше 50 допускается для слоѐв inflation. 

На рисунке 3.14 отображены факторы, отображающие качество сетки для данной 

модели. 

 
а - фактор Aspect Ratio 

 
б - фактор Skewness 

Рис. 3.14. Факторы, определяющие качество сетки:  

а - фактор Aspect Ratio; б - фактор Skewness 

Шаг 11. Рекомендуется после создания геометрии создать компоненты граней Name 

Selection, для упрощения выбора набора граней при задании граничных условий. Для это-

го необходимо нажать правой кнопкой мыши на Named Selections и далее в контекстном 

меню Insert > Named Selections. После этого нужно присвоить имя компоненту и выбрать 

геометрию (рис. 3.15). 
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Рис. 3.15. Компоненты Named Selections 
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3.3 Настройка расчѐтной модели в ANSYS CFX-PRE 

Шаг 1. После построения конечно-элементной сетки, необходимо еѐ передать в 

CFX-Pre. Для этого необходимо нажать на кнопку Mesh компонента Mesh и перетащить 

его в Setup компонента Fluid Flow (CFX), как показано на рис. 3.16. 

 

Рис. 3.16. Создание связи между компонентом Mesh и Fluid Flow (CFX) 

Шаг 3. Запуск модуля ANSYS CFX-Pre осуществляется двойным щелчком левой 

кнопки мыши по вкладке Setup.  

Шаг 3. В меню  Analysis Type выбирается стационарный анализ (Steady State). 

Шаг 4. Создание модели материала рабочего колеса ЭИ698. Для проведения тепло-

вого расчѐта необходимо задать свойства теплопроводности и теплоѐмкости, зависимые 

от температуры. На первом этапе необходимо создать пользовательскую функцию  

(ГМ: Insert > Expressions, Functions and Variables > User Function). Вводиться еѐ имя 

(например, для теплоѐмкости – C1). Далее заполняются поля в Details of C1 по примеру, 

представленному на рис. 3.17. 

Шаг 5. Аналогично создаѐтся пользовательская функция для теплопроводности 

(рис. 3.18). 
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Рис. 3.17. Создание функции теплоѐмкости от температуры 

 

Рис. 3.18. Создание функции теплопроводности от температуры 
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Шаг 6. После создания функции необходимо определить выражение  (ГМ: Insert 

> Expressions, Functions and Variables > Expression). Вводится его имя (например, для 

функции С1 введѐм имя СС1). Далее в поле Details of CC1 необходимо правым щелчком 

мыши вызвать контекстное меню и в пути показанном на рис. 3.19 выбрать нами создан-

ную функцию С1. Далее необходимо указать, что теплоѐмкость является функцией от 

температуры. Для этого нужно вести в круглых скобках Temperature (рис. 3.19).  

 

Рис. 3.19. Определение выражения 

Шаг 7. Для теплопроводности аналогично определяем выражение. 

Шаг 8.  Создаѐм новый материал (ГМ: Insert > Material). В окне Basic Settings не-

обходимо поставить галочку напротив Thermodynamic State и выбрать в появившемся вы-

падающем меню вкладку Solid (рис. 3.20а). Во вкладке Material Properties необходимо за-

дать плотность, поставить галочку напротив Specific Heat Capacity и ввести выражение  

теплоѐмкости СС1 и поставить галочку напротив Thermal Conductivity и ввести выраже-

ние  теплопроводности LL1 (рис. 3.20б). 
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а       б 

Рис. 3.20. Заполнение свойств материала ЭИ698: 

а - основные настройки, б - свойства вещества 

Шаг 9. Следующий шаг заключается в создании доменов  из тел (ГМ: Insert > 

Domain). Всего в данном случае создаѐтся дополнительно следующих 4 домена 

(рис. 3.21): 

-left_cavity 

-polka 

-right_cavity 

-koleso 
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Рис. 3.21. Домены расчѐтной модели 

Шаг 10. Для каждого домена типа Fluid необходимо выбрать и указать данные, как 

показано на примере домена left_cavity (рис. 3.22). 

 

Рис. 3.22. Определение параметров домена left_cavity 
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По существу, настройки материала рабочего тела, модели турбулентности, ссылоч-

ного давления и модели тепловых процессов нет необходимости указывать на данном ша-

ге, поскольку после настройки этих данных для домена соплового аппарата, они автома-

тически применяются ко всем остальным доменам. 

Шаг 11. Для домена рабочего колеса (тип Solid) необходимо выбрать и указать дан-

ные, показанные на рисунке 3.23. Для рабочего колеса необходимо указать ранее создан-

ный материал, частоту вращения, ось вращения, а также необходимо включить опцию те-

плообмена Thermal Energy. 

 
Рис. 3.23. Определение параметров домена koleso 

Шаг 13. После создания доменов на их грани накладываются граничные условия  

(ГМ: Insert > Boundary). В них необходимо указать грань, к которой оно относится, тип 

граничного условия, а также значения параметров рабочего тела для данного типа ГУ. Для 

неопределѐнных граней доменов автоматически создаѐтся условие непроницаемой адиа-

батное стенки. На рис. 3.24 показан порядок заполнения данных для граничного условия 

Inlet домена left_cavity. 

 
Рис. 3.24. Граничное условие Inlet домена left_cavity 
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Граничные условия  типа Wall могут быть вращающимися, или не вращающимися. 

На рисунке 3.25 показан порядок заполнения параметров для вращающейся стенки домена 

left_cavity. 

 

Рис. 3.25. Граничное условие Wall домена left_cavity 

На рисунках 3.26 – 3.28 показан процесс заполнения данных для неподвижных сте-

нок доменов left_cavity, right_cavity и polka. 

 

Рис. 3.26. Граничное условие Wall домена right_cavity 
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Рис. 3.27. Граничное условие Wall домена right_cavity 

 

Рис. 3.28. Граничное условие Wall домена polka 

Следует отметить, что в случае, когда на свободных стенках известна, например, 

температура, тепловой поток или параметры конвективного теплообмена, тогда это можно 

учесть заполнив данные в поле Heat Transfer (рис. 3.29). 

 

Рис. 3.29. Поле Heat Transfer 

Шаг 13. Следующий этап заключается в создании интерфейсов  (ГМ: Insert > 

Domain Interface), которые служат для передачи данных между областями. 
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Создадим интерфейс, моделирующий периодичность сектора домена left_cavity  

(рис. 3.30). Выбирается тип интерфейса Fluid Fluid. Далее выбираются домены и принад-

лежащие к ним грани, на которые будет накладываться условие периодичности. Выбира-

ется опция Rotational Periodicity и ось вращения. 

 
Рис. 3.30. Создание интерфейса периодичности домена left_cavity 

Шаг 14. Аналогично создаются интерфейсы периодичности для доменов right_cavity 

и polka. Создание интерфейса периодичности для домена koleso будет отличаться от пре-

дыдущих лишь указанием типа интерфейса Solid Solid. 

Шаг 15. Создаются интерфейсы передачи данных между доменами жидкости  

(рис. 3.31). 

 
Рис. 3.31. Создание интерфейсов передачи данных между доменами жидкости 
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На рисунке 3.32 показ порядок настройки интерфейса между доменами right_cavity и 

rk. В стационарной постановке решения задачи нет возможности задать в стационарном 

домене rk вращение на стенках лопатки. Из-за этого приходится задавать домену rk вра-

щение при неподвижных его стенках. Это приводят к тому, что возникает необходимость 

передачи данных между вращающимся доменом rk и неподвижным доменом right_cavity, 

которая в данном случае реализуется созданием интерфейса Frozen Rotor. 

 
Рис. 3.32. Создание интерфейса между доменами right_cavity и rk 

 

Шаг 16. Создание остальных подобных интерфейсов происходит аналогичным об-

разом. 

Шаг 17. Для проведения сопряжѐнного теплового анализа необходимо создать ин-

терфейсы между жидкостью и твѐрдым телом, передающие тепловую нагрузку. На рис. 

3.33 представлены 6 интерфейсов для данной модели. Порядок создания интерфейса на 

примере интерфейса между гранями лопатки рабочего колеса доменов rk и koleso показан 

на рисунке 3.34. 

 
Рис. 3.33. Создание интерфейсов между доменами твѐрдого тела и жидкости 
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Рис. 3.34. Создание интерфейсов между доменами rk и koleso 

Шаг 18. На последнем шаге в Ansys CFX-Pre необходимо настроить опции решателя 

(ГМ: Insert > Solver > Solver Control). Здесь необходимо выбрать порядок точности ре-

шения, критерии остановки расчѐта (максимальное количество итерации или уровень не-

вязок), а также вводятся настройки масштаба времени (рис. 3.35). 

 
Рис. 3.35. Details of Solver Control 

 Шаг 19. Далее сохраняем расчѐтную модель  и выходим из Ansys CFX-Pre. 
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3.4 Расчѐт и анализ результатов 

Шаг 1. Решатель запускается в модуле ANSYS CFX-Solver Manager. Запуск модуля 

ANSYS CFX-Solver Manager осуществляется двойным щелчком мыши по Solution. 

Шаг 3. Необходимо определить параметры решения (рис. 3.36). Устанавливаются 

параметры инициализации, алгоритм распараллеливания и количество расчѐтных ядер. 

Поскольку ранее были получены результаты расчѐта в проточной части турбины, исполь-

зуем их в качестве начальных. Для этого в опции Initialization Option поставим Current So-

lution Data (if possible). 

 

Рис. 3.36. Настройки параметров решения 

Шаг 3. Запуск решения осуществляется нажатием кнопки . 

Шаг 4. После того, как невязки будут стабилизироваться, следует повысить значе-

ние Timescale Factor. Это можно осуществить при помощи команды Dynamically edit set-

ting of the run in progress  (рис. 3.37). 
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Рис. 3.37. Динамическое изменение параметров расчѐта 

Завершение расчѐта происходит автоматически при достижении уровня указанных 

невязок, либо установленного максимального числа итераций. При завершении расчѐта 

создаѐтся файл результатов *.res. 

Шаг 5. Постпроцессор запускается в модуле CFD-Post. Запуск модуля CFD-Post 

осуществляется двойным щелчком мыши по Results. 

Модуль постпроцессора позволяет отображать результаты в виде контуров, векто-

ров, линий тока и др. на имеющихся геометрических объектах, либо на созданных вспо-

могательных геометрических объектах. Доступ к данным инструментам можно получить 

по следующему пути ГМ: Insert. Также можно проводить вычисление интегральных па-

раметров характерных сечений при помощи функции калькулятора (ГМ: Tools > Function 

Calculator). 

Результаты расчѐта показаны на рисунках 3.38-3.39. 



81 

 

Рис. 3.38. Распределение полей температур диска 

 

Рис. 3.39. Вектора скоростей в области бандажной полки 
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4 МОДЕЛИРОВАНИЕ НАПРЯЖЕННО-ДЕФОРМИРОВАННОГО СОСТОЯНИЯ 

КОЛЕСА ТУРБИНЫ 

4.1 Разработка геометрической модели рабочего колеса турбины ТНА 

Для относительно быстрого расчета в Workbench нужно использовать не весь диск, а 

только его сектор, циклически повторяющийся столько же раз, сколько лопаток на диске. 

Поэтому перед экспортированием модели в Workbench вам потребуется разрезать колесо 

турбины. Методика прочностного расчѐта изложена в работах [6, 9]. 

Шаг 1. Откройте объемную модель колеса турбины (рис. 4.1). 

 
Рис.4.1. Объѐмная модель колеса турбины в Unigraphics NX 

На панели инструментов кликните: Элемент → Координатная плоскость. Выбе-

рите тип Сквозь объект. В качестве объекта укажите ось вращения (рис. 4.2). 

 
Рис.4.2. Создание вертикальной координатной плоскости 
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Шаг 2. Создайте новую координатную плоскость, тип Под углом. В качестве объек-

та укажите последнюю созданную плоскость, а в качестве Сквозной оси – выделите ось 

вращения колеса (рис. 4.3).  Угол -18 градусов. Создайте вторую плоскость под углом к 

только что построенной плоскости, угол укажите 10 градусов. 

 
Рис.4.3. Создание координатной плоскости под углом 

Шаг 4.   Создайте горизонтальную  плоскость, выберите тип Под углом, угол 90 гра-

дусов. Плоским объектом будет служить созданная вами вертикальная координатная 

плоскость. Проверьте правильность построения координатных плоскостей: лопатка долж-

на находиться между  двумя построенными под углом плоскостями (рис. 4.4) 

 

Рис.4.4. Модель колеса турбины с построенными координатными плоскостями 

Шаг 4. Выберите на панели инструментов: Элемент → Обрезка тела (рис. 4.5). 

Выберите в качестве тела колесо турбины, а инструментом – горизонтальную плоскость. 

Чтобы выбрать, с какой стороны будет обрезаться колесо турбины, в открывшемся окне 
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кликайте Сменить направление. После обрезки горизонтальной плоскостью останется 

одна из половин (рис. 4.6). 

 

Рис. 4.5. Меню обрезки тела 

 

Рис. 4.6. Результат обрезки горизонтальной плоскостью 

Шаг 4. Аналогичным способом с помощью обрезки тела срежьте лишние части ко-

леса турбины и оставьте только один сектор с лопаткой (рис 4.7). 
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Рис. 4.7. Объѐмная модель сектора колеса турбины 

Шаг 5.  Полученный фрагмент диска сохраните в формате Parasolid:  Файл → Экс-

порт → Parasolid…  Выберите тело, нажмите ОК. Выберите путь, куда будете сохранять 

новый файл и укажите имя. 

 

Рис. 4.8. Экспорт модели сектора колеса турбины в формат Parasolid 

Шаг 6.  Расчет сектора колеса турбины на прочность будет проходить с приложен-

ными газовыми силами, которые были рассчитаны ранее в Fluid Flow (CFX) (рис. 4.9). 
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Рис. 4.9 Стартовый проект в Workbench 

 

Рис. 4.10. Перемещение модуля Static Structural 

Шаг 7. В Workbench в окне Toolbox найдите и перетащите модуль Static Structural в 

окно Project Schematic (рис. 4.10).  

Шаг 8. Для создания связи между модулями (чтобы передать  газовые нагрузки из 

газодинамического расчета во Fluid Flow) захватите ЛКМ Solution и перетащите его из 

модуля Fluid Flow (CFX) в Setup модуля Static Structural (рис. 4.11). 

 

Рис. 4.11. Размещенный модуль Static Structural в новом проекте 

Шаг 9. Задайте свойства материала. Для этого кликните ПКМ по строке элемента 

Engineering Data модуля Static Structural. После загрузки появится рабочая область моду-

ля, из которой можно управлять материалами (рис. 4.12). В Engineering Data содержатся 

все свойства материалов используемых в Static Structural. Здесь по умолчанию использу-
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ется материал Structural Steel (плотность – 7850 , модуль упругости – , ко-

эффициент Пуассона – 0,3). При необходимости можно выбирать готовый материал из 

библиотеки или изменять существующий. 

 

Рис. 4.12. Рабочая область Engineering Data 

В области Table of Properties Row 2: Density введите плотность 8320 (рис. 4.13). 

 

Рис. 4.13. Плотность материала 

В области Table of Properties Row 2: Isotropic Elasticity оставьте без изменений 

(рис. 4.14) 
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Рис. 4.14 – Изотропная упругость 

Чтобы вернуться обратно на рабочую область Ansys Workbench кликните кнопку Re-

turn to Project. 

Шаг 10. Откройте Geometry в блоке Static Structural. В Ansys Workbench есть воз-

можность редактировать объемную модель, не прибегая к другим программам, что суще-

ственно облегчает работу с проектом, так как можно загрузить готовую модель и затем 

менять его геометрические размеры и получать требуемые параметры не выходя из Work-

bench. В открывшемся диалоговом окне укажите единицу измерения в миллиметрах 

(рис. 4.15). 

 

Рис. 4.15. Выбор размерности детали 

Шаг 11. File → Import External Geometry File.  Выберите полученный файл Paraso-

lid, нажмите Открыть. Для того, чтобы модель появилась в  окне DesignModeler  выделите 

в окошке Tree Outlite строчку Import1 и нажмите кнопку Generate – сгенерируется объем-

ная модель сектора колеса турбины (рис. 4.16). 
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Рис. 4.16. Объѐмная модель сектора колеса турбины 

Шаг 12. В местах стыка лопаточного пера с бандажной полкой и с диском присутст-

вуют большие напряжения, для уменьшения их величины и нужно создать скругления. 

Blend → Fixed Radius (рис. 4.17). 

 

Рис. 4.17. Путь вызова меню скругления 

С зажатой клавишей ctrl выберите дуги в местах стыка пера лопатки с диском 

(рис. 4.18). Укажите Radius 2 мм, кликните Apply. Аналогично выделите дуги в местах 

стыка пера лопатки с бандажной полкой, укажите Radius 1 мм, кликните Apply.  
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Рис. 4.18. Место стыка пера лопатки и диска турбины 

Нажмите Generate, на модели должны появиться скругления (рис. 4.19). 

 

Рис. 4.19. Объемная модель сектора со скруглениями 

Шаг 14. Закройте DesignModeler. 
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4.2 Построение сеточной модели диска турбины 

Шаг 1. Перейдите в Model в блоке Static Structural. Кликните в дереве модели Coor-

dinate Systems ПКМ, Insert → Coordinate System (рис. 4.20).  

 

Рис. 4.20. Выбор координатной системы 

В качестве геометрии выберите внутреннюю (вогнутую) поверхность сектора колеса 

турбины, нажмите Apply (рис. 4.21).   

 

Рис. 4.21. Выбор геометрии для цилиндрической координатной системы 

Проделайте следующие изменения : Definition → Type → Cylindrical; Principal axis 

→ Axis → Z.  Т.е. вы применили цилиндрическую систему и указали ось вращения Z 

(рис. 4.22). 
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Рис. 4.22. Создание цилиндрической координатной системы 

Шаг 2. Так как здесь сектор не самостоятельная деталь, а часть колеса турбины, об-

разованная разрезом тела, то поверхности контакта сектора с диском нужно связать, что-

бы Ansys проводил расчет целого диска. В дереве модели ПКМ: Model → Insert → Sym-

metry (рис. 4.23). 

 

Рис. 4.23. Задание симметрии 

Шаг 4. Кликните по Symmetry ПКМ: Insert → Cyclic Region (рис. 4.24). 
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Рис. 4.24. Настройка симметрии 

Кликните Low Boundary и выберите с зажатой клавишей ctrl две поверхности, выде-

ленные зеленым цветом на рисунке 4.25. 

 

Рис. 4.25. Выбор геометрии симметрии 
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Кликните High Boundary и выберите такие же поверхности с другой стороны секто-

ра, нажмите Apply (рис. 4.26). 

 
Рис. 4.26. Выбор геометрии симметрии 

Шаг 4. Кликните ПКМ на Mesh в дереве модели: Insert →Method (рис. 4.27). 

 
Рис. 4.27. Создание сетки 
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Кликните Geometry, выберите тело и нажмите Apply. Выберите Method → Tetrahe-

drons (рис. 4.28). Снова ПКМ на Mesh: Insert → Sizing. Выберите все тело, нажмите Apply. 

В дереве модели появится пункт Body Sizing. Введите в Element Size значение 0,002. 

 

Рис. 4.28. Выбор метода построения сетки 

Шаг 5. ПКМ на Mesh: Insert → Sizing. На панели инструментов выберите метод вы-

деления Face (рис. 4.29). Выделите скругление между пером лопатки и бандажной полкой 

с зажатой клавишей ctrl (рис. 4.30). нажмите Apply. Введите в Element Size значение 0,005. 

Аналогичные действия проведите со скруглением между пером лопатки и диском. 

 

Рис. 4.29. Выделение разных объектов 
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Рис. 4.30. Задание сетки на скруглениях 

Шаг 6. Чтобы сетка сгенерировалась (рис. 4.31), нажмите Update на панели инстру-

ментов. 

 

Рис. 4.31. Сгенерированная сетка сектора колеса турбины 
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4.3 Задание нагрузки и граничных условий 

После создания сеточной модели следует задание нагрузки и граничных условий. 

Газовые нагрузки ранее были перенесены из Fluid Flow (CFX) в  Setup Static Structural. 

Чтобы начать приложение газовых нагрузок к поверхностям сектора, а также задания гра-

ничных условий нужно выйти из Model и перейти в Setup модуля Static Structural 

Шаг 1. Static Structural → Insert → Displacement (рис. 4.32). Выберите поверхность, 

показанную на рис. 4.33 желтым цветом. Выберите Coordinate system → Coordinate sys-

tem; Z component → 0. 

 

Рис. 4.32. Фиксирование детали 

 

Рис. 4.33. Поверхность закрепления 
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Шаг 2. Для задания вращения детали пройдите по пути: Static Structural → Insert → 

Rotation Velocity. Выберите координатную систему Coordinate system → Coordinate sys-

tem, Define By → Components. В Z component введите значение 1828 (рис. 4.34). 

 
Рис. 4.34. Задание вращения 

Шаг 4. Выполните: Static Structural → Insert → Thermal Condition. Выберите тело, на-

жмите Apply (рис. 4.35). 

 
Рис. 4.35. Назначение температурного состояния 
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Шаг 4. После перехода из Modal в Setup модуля Static Structural в дереве модели 

должно появиться Imported load (Solution) (рис. 4.36). 

 

Рис. 4.36. Импорт газовых нагрузок в меню 

Шаг 5. Импортируйте давление, для этого нажмите ПКМ: Imported Load (Solution) 

→ Insert → Pressure (рис. 4.37). В меню импорта выберите в Geometry поверхности, куда 

надо прикладывать давление. 

 
Рис. 4.37. Выбор давления 

Выделите поверхности лопатки, в Geometry нажмите Apply. В CFD Surface выберите  

домен rk_blade1_p Side 1 (4.38). 

 
Рис. 4.38. Выбор геометрии для импорта давления на лопатку 
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Кликните ПКМ Imported Load (Solution) → Import Load. В результате получится 

векторное поле давлений на поверхностях лопатки диска (рис. 4.39). 

 
Рис. 4.39. Векторное поле давлений на лопатке 

Шаг 6. Убедитесь в правильности импорта: зайдите в Imported Load (Solution) → 

Imported Pressure → Imported Load Transfer Summary и в самом конце посмотрите про-

цент правильно импортированных узлов (рис. 4.40). 

 
Рис. 4.40. Проверка совпадения узлов давлений 

Шаг 7. Теперь аналогично нужно импортировать все остальные давления, ниже 

приведены рисунки 4.41 – 4.44. Названия доменов есть на рисунках и дублированы в под-

рисуночных надписях. Необходимо выделить также геометрии, как на рисунках и выбрать 

соответствующие домены в CFD Surface.  
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Рис. 4.41. Выбор геометрии для импорта давлений домена l_cavity_ggi p Side 2 

 

 
Рис. 4.42. Выбор геометрии для импорта давлений домена r_cavity_ggi p Side 2 
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Рис. 4.43. Выбор геометрии для импорта давлений домена polka_rotor_p 

 

 Поверхности не совпадают во втулке и периферии в CFX расчете и в прочностном 

расчете Static Structural. Поэтому на периферийную поверхность диска и нижнюю поверх-

ность бандажной полки нужно приложить среднее давление потока, иначе при простом 

импорте, как делалось выше будут большие несовпадения узлов.  

Шаг 7. Для того чтобы узнать эти давления, войдите в Ansys Workbench в Results 

модуля Fluid Flow (CFX). В открывшемся окне перейдите во вкладку Expressions 

(рис. 4.44). Кликните ПКМ по пустому полю в этой вкладке и нажмите New… Задайте 

любое имя новому выражению, например, pressure. 

 

Рис. 4.44. Создание нового выражения 

Во вкладке Definition кликните по пустому полю ПКМ, выберите Functions → CFD-

Post → areaAve. В данном случае это создание функции для измерения по плоскости 
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(рис. 4.45). В новой функции кликните ПКМ в закрытых скобках и введите переменную: 

Variables → Pressure .После символа @  введите: Location → Other… → rk_hub_p Side 1. 

Для расчета давления нажмите Apply. Результат расчета вы увидите в поле Value 

(рис.4.46). 

 

Рис. 4.45. Создание функции 

 

Рис. 4.46. Результат расчѐта 

Шаг 8. Аналогичные действия в этом же окне проделайте для вычисления среднего 

давления на поверхности rk_shroud_p Side 1. 
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Шаг 9. Для задания давления на поверхности перейдите по пути: Static Structural  → 

Insert → Pressure (рис. 4.47) 

 
Рис. 4.47. Ввод среднего давления 

В поле геометрии добавьте периферийную поверхность диска, нажмите Apply 

(рис. 4.48). В поле Magnitude введите измеренное среднее давление на этой поверхности. 

 
Рис. 4.48. Выбор геометрии для задания среднего давления домена rk_hub _p Side 1 

 

Шаг 10. Аналогично задайте давление и на внутреннюю поверхность бандажной 

полки (рис. 4.49). 
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Рис. 4.49. Выбор геометрии для задания среднего давления домена rk_ shroud _p Side 1 

Шаг 11. Для импорта поля температур пройдите по пути: Imported Load (Solution) 

→ Insert → Body Temperature (рис. 4.50). Для Geometry выберите все тело сектора, на-

жмите Apply, в CFD Surface доменом будет koleso (рис. 4.51). 

 
Рис. 4.50. Путь в меню для импорта поля температур 
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Рис. 4.51. Выбор тела для импорта поля температур домена koleso 

Шаг 12. Когда все поверхности указаны, нужно импортировать нагрузки: Imported 

Load (Solution) → Import Load. (рис. 4.52).  

 
Рис. 4.52. Импорт давлений и температуры 



107 

4.4 Проведение расчѐта и анализ полученных результатов 

Шаг 1. Для прочностного расчета нажмите ПКМ: Static Sructural → Solve 

(рис. 4.53).  

 

Рис. 4.53. Начало прочностного расчета 

Шаг 2. Для того, чтобы получить поле напряжений на выходе кликните ПКМ: Solu-

tion → Insert → Stress → Equivalent (von-Mises) (рис. 4.54).  

 

Рис. 4.54. Выбор эквивалентных напряжений 

Шаг 4. Выведите радиальные напряжения: Solution → Insert → Stress → Normal. В 

Normal Stress выберите цилиндрическую систему координат и укажите ось X (рис. 4.55). 
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Рис. 4.55. Задание окружных напряжений 

Шаг 4. Выведите окружные напряжения: Solution → Insert → Stress → Normal. В 

Normal Stress выберите цилиндрическую систему координат и укажите ось Y.  

Шаг 5. После проделанных операций пересчитайте напряжения и перемещения: So-

lution → Solve. Кликните Equivalent Stress: на  экран будет выведен целый диск с эквива-

лентными  напряжениями (рис. 4.56). 

 

Рис. 4.56. Эквивалентные напряжения диска турбины 
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Шаг 6. Чтобы посмотреть напряжения внутри модели, ее нужно рассечь плоскостью 

сечения, которая создается в окне Section Planes (рис. 4.57). Если окно Section Planes от-

сутствует, то поставьте галочку по пути: View → Windows → Section Planes (рис. 4.58). 

 

Рис. 4.57. Окно Section Planes 

 

Рис. 4.58. Включение окна Section Planes 

Шаг 7. Создайте секущую плоскость New Section Plane и проведите с зажатой ЛКМ 

линию через центр диска, чтобы рассечь его пополам (рис. 4.59-4.60). 
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Рис. 4.59. Проведение секущей линии через центр вращения диска 

 

Рис. 4.60. Результат сечения секущей плоскостью 

Шаг 8. Кликните Normal Stress: на  экран будет выведен разрезанный диск с ради-

альными напряжениями (рис. 4.61). 
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Рис. 4.61. Радиальные напряжения диска турбины 

Шаг 9. Кликните Normal Stress 2: на экран будет выведен разрезанный диск с ок-

ружными напряжениями (рис. 4.62). 

 

Рис. 4.62. Окружные напряжения диска турбины 
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ЗАКЛЮЧЕНИЕ 

В настоящем пособии изложены основные положения решения сопряжѐнных задач 

газодинамического, теплового и прочностного проектирования одних из наиболее нагру-

женных и ответственных структурных элементов турбонасосных агрегатов жидкостных 

ракетных двигателей – рабочих  колѐс турбин как совокупности диска и рабочих лопаток. 

Они в значительной степени определяют экономическую эффективность и надѐжность 

всего ЖРД. 

Как следует из уже имеющегося опыта [4], использование компьютерных техноло-

гий в сквозных курсовых работе и проекте по ТНА, выполняемых на кафедрах ТДЛА и 

КиПДЛА, способствует более качественной подготовке специалистов.  Применение  ос-

новных приѐмов работы с гидродинамическим пакетом ANSYS CFX и прочностным паке-

том ANSYS Static Structural для моделирования напряжѐнно-деформированного состояния 

рабочих колес турбин ТНА ЖРД в сопряжѐнной постановке, содержащихся в настоящем 

пособии, будет способствовать модернизации образования на факультете ДЛА СГАУ. 

Этому содействуют подробно разобранные в настоящем пособии особенности проведения 

газодинамического, теплового и прочностного анализа, использование результатов газо-

динамического расчѐта в качестве граничных условий при прочностном анализе. 

Получены следующие результаты: 

- проведѐн анализ разработанных и перспективных отечественных и зарубежных конст-

рукций турбин ТНА ЖРД; 

- выявлены особенности рабочего процесса и проектирования рабочих колѐс турбин 

ТНА ЖРД; 

- разработана методика численного моделирования потока в турбинах  с использовани-

ем CFD-пакета ANSYS CFX; 

- разработана методика численного моделирования напряжѐнно-деформированного со-

стояния  неравномерно нагретых  быстро вращающихся рабочих колѐс турбин с ис-

пользованием прочностного пакета ANSYS Static Structural; 

- разработаны учебно-методические материалы, позволяющие студенту освоить мето-

дику сопряжѐнного (газодинамического, теплового  и прочностного) моделирования 

турбин ТНА ЖРД с использованием CFD-пакета ANSYS CFX и прочностного пакета 

ANSYS Static Structural. 
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